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Probability5
Introduction
Chapter 5 explains the tools of probability, which enable data analysts to quantify the level of 
uncertainty in statistical inference. Section 5.1 introduces experiments, outcomes, events, and 
sample spaces. The classical method, the relative frequency method, and the subjective method of 
assigning probabilities are introduced, as well as the Law of Large Numbers. In Section 5.2, stu-
dents learn about combining events using the concepts of union, intersection, and complement. 
Section 5.3 examines conditional probability, independent events, and sampling with and without 
replacement. In Section 5.4, counting methods are used to find the number of combinations and 
permutations of a set of objects.

From the Author
Section 5.1 Introducing Probability
•	 You may want to stress the “difference in perspective” of this chapter from previous chapters. 

See the Developing Your Statistical Sense feature on page 241.

•	 Two new examples are provided to ease the student’s learning curve into probability: Example 1 
Probability Models, and Example 2 Determining Unusual or Likely Outcomes.

•	 You may note the increased use of contingency tables (crosstabulations) in Chapter 5 to help 
explain various aspects of probability, such as Example 10 Relative Frequency Method, which 
uses the Chapter 5 Case Study: The Gardasil Vaccine.

•	 The probability chapter offers many opportunities to increase student motivation by talking 
about the application of probability to games of chance. For example, many students enjoy 
working with the two-dice sample space or the deck of cards sample space.

Section 5.2 Combining Events
•	 Students who have trouble with the concept of intersection may benefit from a look at Table 6 

on page 261. Consider the row to be a “street” and the column to be a different street, then fe-
male survivors of the Titanic lie in the intersection of these two streets. Contingency tables 
work well for this.

Section 5.3 Conditional Probability
•	 In conditional probability, students often confuse “B given A” with “B and A.” Stress the Devel-

oping Your Statistical Sense feature along with Figure 17 on page 272, to help dispel this 
confusion.

•	 It may save your gambling students a lot of money if you discuss the Gambler’s Fallacy in  
Example 21 on page 275.

•	 Coverage of Bayes’ Rule has been added to this section. See page 282 and Example 31.
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•	 Many business and engineering students may need to learn quality control methods. Accep-

tance sampling on page 300 is a widespread method for businesses to track quality across their 
enterprises.

Teaching Tips
In Chapters 1–4, the students used statistics, tables, and graphs to describe a data set. This is de-
scriptive statistics. However, here in Chapter 5, we need to shift our point of view. No longer are 
we given a data set to describe. Instead, we are presented with an experiment, with certain out-
comes and events defined. We need to find probabilities of these outcomes and events. This is the 
realm of probability, which has a different perspective from descriptive statistics.

In-Class Activities
1. To explain the difference between the classical method and the relative frequency method of 
assigning probabilities, first ask students, “What is the probability of rolling a 72 with a 100-sided 
die? This is an example of an event where we use the classical method of probability.” Then ask, 
“What is the probability of an event that uses the relative frequency method, such as selecting 
a student at random from a college in your state?” and “What is the probability that the student 
is enrolled in an elementary statistics class that semester? These are examples of events where 
we use the relative frequency method of probability.” What is the difference in how we find the 
probabilities in these cases? Why is the first a use of the classical method and the last the relative 
frequency method. Students will be able to find the first probability even if they have never rolled 
a 100-sided die before, but they won’t be able to find the second probability without knowing the 
number of students enrolled at a college in their state and the number of students enrolled in an 
elementary statistics class.

2. To explain the counting rules, ask students to think about how they would perform the 
task. Suppose you wanted to line up six people. Ask them how many ways can be used to select 
a first person in line. Have them select a first person. Now ask them how many ways can be 
used to select a second person in line. Have them select a second person. Continue this process 
until all six people are lined up. Then show that there are 6 · 5 · 4 · 3 · 2 · 1 = 720 ways to line 
up six people.

3. To illustrate the Law of Large Numbers, have students do an experiment in class, such as 
flipping a coin or rolling a die. Divide them into groups of 2 or 3, and perform the experiment 
50 times. Ask students to keep track of the number of heads and tails if they flip coins or 
the number of 1s, 2s, . . . 6s if they roll a die. Pool all the results, and have students calculate 
the relative frequencies. Ask them to compare the relative frequencies to the theoretical 
probabilities.
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4. Have you ever taken a multiple-choice test where you couldn’t decide between the 
alternatives and wished you could flip a coin or roll a die to decide? Suppose you are facing 
a four-question multiple-choice exam, with three alternatives (A, B, or C) for each question, 
and you have no clue as to which answers are correct. In this activity, you will calculate the 
probability of getting one or more answers right.

a. Why does it make sense to use the classical method?

b. Draw a tree diagram for this four-question test—the experiment.

c. What is the probability that you will answer a particular question correctly?

d. What is the probability that you will answer two questions correctly?

e. What is the probability that you will answer three questions correctly?

f. What is the probability that you will answer all four questions correctly?

g. Suppose that you need to answer at least three out of the four questions correctly to 
pass the test. What is the probability that you will pass?

5. We use simulation to estimate the probabilities we calculated in Activity 4. We use a single 
fair die to determine our responses.

a. How should we “code” the die results, so that there is an even chance of choosing A, 
B, or C?

b. Your answer to each exam question will be either right or wrong. Why not use a coin 
toss instead of a die roll for this simulation?

c. We need to code the probability of getting a correct answer. For each question,  
A, B, or C is correct. We want to simulate the probability of guessing correctly, 
which is 1/3. How do you code the die roll so that the probability of guessing  
correctly is 1/3?

d. Perform 20 trials of the experiment. Rolling the die one time is considered as 
answering one test question. Therefore, rolling the die four times is considered 
as one “trial” of the experiment (taking the test). For each trial, keep track of the 
number of “right” and “wrong” guesses. Answer questions (e)–(h) using your simu-
lation results.

e. Estimate the probability that you will answer the first and only the first question 
correctly.

f. Estimate the probability that you will answer exactly two questions correctly.

g. Estimate the probability that you will answer exactly three questions correctly.

h. Estimate the probability that you will answer all four questions correctly.

i. Estimate the probability that you will pass the test.

Supplements
•	 StatTutor 6.1, 6.2, 10.1–10.3, 12.1–12.6

Applets
The Law of Large Numbers applet is referenced in Chapter 5 to compute relative frequencies 
for experiments and for Exercises 99 and 100 in Section 5.1. Activities on probability simula-
tion can be found at http://mathforum.org/mathtools/sitemap2/ps/. The site Online Statistics: 
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An Interactive Multimedia Course of Study has a Probability applet that demonstrates several 
simulations: http://onlinestatbook.com/index.html.

Videos
•	 Against All Odds: Inside Statistics: www.learner.org/resources/series65.html

•	 Program 18: Introduction to Probability 

•	 Program 19: Probability Models 

Web Sites
•	 CAUSEweb provides resources for teaching statistics: https://www.causeweb.org/.

•	 This Web site has a collection of 20 class projects: www.amstat.org/publications/jse/v6n3/
smith.html.

•	 This Texas Instruments Web site has a host of TI-83/84 statistics activities: http://education 
.ti.com/educationportal/sites/US/nonProductSingle/activitybook_83_statistics.html.

•	 This Web site lists other sites that do statistical calculations: http://statpages.org/.

•	 This Web site lists numerous activities on all topics: http://mathforum.org/mathtools/
sitemap2/ps/.
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239

The Gardasil vaccine 
The Centers for Disease Control and Prevention (CDC) recommends routine 
vaccination with Gardasil for boys and girls ages 11 and 12, in order to combat 

the HPV virus. One reason for this is that it has been shown that 100% of cervical cancer 
patients have been infected with the HPV virus.1 The large data set Gardasil (Source: Journal 
of Statistics Education2) contains information regarding 1413 young women who underwent 
vaccination treatment. To complete the vaccination, a series of three shots must be undertaken. 
In the Chapter 5 Case Study, The Gardasil Vaccine, we explore whether patient location, 
insurance type, gender, and other factors affect a patient’s probability of completing the 
vaccine treatment.

 ● In Section 5.1, we use the relative frequency method to assign probabilities to whether or 
not patients completed their Gardasil treatment.

 ● In the Section 5.1 exercises, working with the large data set Gardasil, we explore some 
probabilities about clinic location and patient insurance type, using the tools and tech-
niques learned in the section. 

 ● Again working with the large data set Gardasil, in the Section 5.2 exercises we exam-
ine probabilities regarding patient completion of the treatment and whether the patient 
received medical assistance, using contingency tables. 

 ● In an example in Section 5.3, we apply the 1% Guideline to help find the probability that 
two randomly selected patients completed the treatment.

 ● Later in Section 5.3, we apply Bayes’ Rule using a crosstabulation of the variables com-
pleted and insurance type.

 ● Then, in the Section 5.3 exercises, we use a contingency table of completed and practice 
type (pediatric, family, or OB/GYN) to calculate some conditional probabilities. Later in 
the Section 5.3 exercises, we work with the large data set Gardasil to explore some con-
ditional probabilities about patient completion and the age group of the patient.

The Big PicTure

Where we are coming from and where we are headed . . .
 ● Chapters 1–4 dealt with descriptive statistics that summarize data. In later chapters, we 

will learn inferential statistics, which generalize from a sample to a population. But general-
izing involves uncertainty.

 ● Chapter 5 teaches us the language of uncertainty: probability. We will learn how to 
quantify uncertainty, using experiments, events, outcomes, rules for combining events, con-
ditional probability, and counting methods.

 ● In Chapter 6, “Probability Distributions,” we learn about the two most important probability 
distributions, the normal and the binomial, which will be our companions for the remainder 
of the text.

case  
sTudy
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240 Chapter 5 Probability

Imagine you are striding down the midway of your local town fair, when a particular 
game of chance catches your eye. The object of this game is to roll a six on a single roll 
of a single fair die. If you do so, you win $5. It costs $1 to play the game. What is the 
likelihood of winning?

To show how to solve this problem, we must first introduce the building blocks of 
probability.

Building Blocks of Probability
Our daily lives are filled with uncertainty, seemingly governed by chance. We try to cope 
with uncertainty by estimating the chances that a particular event will occur. We are 
expected, on a daily basis, to make intelligent decisions about probabilities. Consider the 
following scenarios, and think about how the italicized words all refer to uncertainty:

● What is the chance that there will be a speed trap on this stretch of I-95 on a par-
ticular day?

● What is the likelihood that this lottery ticket will make me rich?

● What is the probability that this throw of the dice will come up a seven?

Sometimes, the amount of uncertainty in our daily lives is so great that there 
appears to be no order to the world whatsoever. However, if you look closely, there are 
patterns in randomness. In this chapter, we learn to become better decision makers by 
becoming acquainted with the tools of probability in order to quantify many of the 
uncertainties of everyday life.

1

5.1 Introducing Probability

OBjecTiveS By the end of this section, I will be able to . . .
1 Understand the meaning of an experiment, an outcome, an event, and a 

sample space.
2 Describe the classical method of assigning probability.
3 Explain the Law of Large Numbers and the relative frequency method of 

assigning probability.

The probability of an outcome represents the chance or likelihood that the outcome will occur.

Let us acquaint ourselves with the building blocks of probability, starting with the 
concept of an experiment. In probability, an experiment is any activity for which  
the outcome is uncertain. Consider the stock market, for example. Suppose you own 
100 shares of Consolidated Widgets and are interested in what the share price will be 
at the end of trading tomorrow. Will the share price increase or decrease? The actual 
result is uncertain, so this is an example of an experiment. Each of the possible results 
of the experiment is called an outcome. Another example of an experiment is when 
you toss a coin. In the coin-toss experiment, the result may be heads or it may be tails. 
The collection of all possible outcomes is called the sample space. The sample space 
for the coin-toss experiment is {heads, tails} or {H, T}. Following are some common 
experiments, together with their sample spaces.

Experiment Sample space

Roll a single six-sided die {1, 2, 3, 4, 5, 6}

Toss two coins {HH, HT, TH, TT}

Play a video game {win, lose}

We use brackets like these { } to 
enclose a set of outcomes.
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2415.1 Introducing Probability

We use the building blocks of probability to investigate the likelihood of an out-
come or event.

Building Blocks of Probability
An experiment is any activity for which the outcome is uncertain.
An outcome is the result of a single performance of an experiment.
The collection of all possible outcomes is called the sample space. We denote the sample 
space S.
An event is a collection of outcomes from the sample space. To find the probability of an 
event, add up the probabilities of all the outcomes in the event.

rules of Probability
1.  The probability P(E ) for any event E is always between 0 and 1, inclusive. That is,  

0 # P(E ) # 1.
2.  Law of Total Probability: For any experiment, the sum of all the outcome probabilities 

in the sample space must equal 1.

When we talk about the probability of some outcome, we are referring to a number 
that indicates how likely the particular outcome is. The notation P(A) stands for “the 
probability that outcome A occurred.” Say we define outcome W to be “you win the 
video game.” Then “the probability that you win the video game” can be denoted as 
P(W ). Probabilities abide by the following rules.

From the definition, the probability of an event is a proportion. Therefore, proba-
bility cannot be negative because proportions cannot be negative, and probability can-
not be greater than 1 (100%) because an event cannot occur more than 100% of the 
time. A probability model is a table or listing of all the possible outcomes of an 
experiment, together with the probability of each outcome. A probability model must 
follow the Rules of Probability.

If the probability that you 
calculated is negative or 
greater than 1, then you 

should try again.

Caution

!

The following table shows some typical events for the experiments in the table on 
page 240.

Experiment Sample space Typical events

Roll a single die {1, 2, 3, 4, 5, 6} E: roll an even number 5 {2, 4, 6}
L: roll a 4 or larger 5 {4, 5, 6}

Toss two coins {HH, HT, TH, TT} H: exactly one head 5 {HT, TH}
T: at most one tail 5 {HH, HT, TH}

Play a video game {win, lose} W: win 5 {win}
L: lose 5 {lose}

A Different Perspective
As you read this chapter, notice that the perspective differs from that in previous 
chapters. Earlier, we were looking at a data set and trying to describe it graphically 
and numerically. Now, instead of trying to describe a data set, we are faced with an 
experimental situation, and our task is to calculate probabilities associated with 
various outcomes in the experiment.

Developing Your 
Statistical Sense
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242 Chapter 5 Probability

b. You ask another friend to go to a concert.

Outcome Probability

Yes 0.5

No 0.5

Maybe 0.5

c. You play a single game of roulette and bet on red.

Outcome Probability

Win 0.47

Lose 0.53

Solution
To be a valid probability model, each scenario must meet both rules of probability.

a. The probability that your friend likes pistachio ice cream may not be very high, 
but it cannot be negative. This violates the first rule of probability that every 
event must have probability between zero and one. Note that, even though the 
second rule of probability is fulfilled (the probabilities sum to one), we 
nevertheless do not have a valid probability model here.

b. Here, the first rule of probability is met, but the second one is violated. The sum 
of the three probabilities is 0.5 + 0.5 + 0.5 = 1.5. This is not equal to one, so 
that we do not have a valid probability model here either.

c. Here, both probabilities lie between zero and one, so that the first rule of probability 
is met. Also, the sum of the two probabilities is 0.47 + 0.53 = 1.00, which fulfills 
the second rule of probability. Therefore, (c) represents a valid probability model.

NOW YOU CAN DO
Exercises 11–16.

Throughout the remainder of this book, you will often be asked to calculate the prob-
ability of various events. Table 1 contains the meanings of some values of probability.

examPle 1  Probability models

For the following three scenarios, determine whether or not a valid probability model 
exists:

a. You ask your friend what his favorite ice cream flavor is.

Outcome Probability

Mint chocolate chip 0.25

Pistachio –0.25

Vanilla 0.50

Other 0.50

Table 1 Meaning of some probability values

Probability value Meaning

Near 0 Outcome or event is very unlikely.

Equal to 0 Outcome or event cannot occur.

Near 1 Outcome or event is nearly certain to occur.

Equal to 1 Outcome or event is certain to occur. It’s “a sure thing.”

Low Outcome or event is unusual, say, with probability less than 0.05.

High Outcome or event is likely to happen.
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2435.1 Introducing Probability

When we perform an experiment, it is a “sure thing” that one of the outcomes in 
the sample space will occur. For example, when you toss a coin, you know that it will 
be either heads or tails. Put into probability terms, the sum of the probabilities of all the 
individual outcomes must equal 1, which is the Law of Total Probability we mentioned 
above.

classical Method of Assigning Probability
Many people have a certain degree of intuition when it comes to assigning probabili-
ties. For example, when asked what the chances are of rolling a 6 on a single toss of a 
fair die, many people would quite correctly answer 1/6. However, intuition can often 
let us down. For example, when asked what the chances are of observing two heads 
when you toss a fair coin twice, many people would incorrectly respond 1/3. (“Well, 
it’s either both heads or both tails or one of each.” The correct answer is in fact 1/4.) In 
this section, we learn how to quantify our methods of assigning probabilities, so that 
we don’t have to depend on intuition alone.

2

examPle 2  Determining unusual or likely outcomes
For the following probabilities, determine the meaning of the indicated probability:

a. The weatherman said that the chance of rain tonight was near 100%.

b. The coach said that after that last loss, the team had no chance to make the 
playoffs.

c. The doctor said that the chance of a negative reaction to the planned procedure 
was 3%.

Solution
a. A value of near 100% is near 1. Therefore, it is nearly certain to occur that we 

will have rain tonight.

b. No chance means a probability equal to zero. Therefore, it cannot occur that the 
team will make the playoffs.

c. The chance of a negative reaction is 3%, or 0.03. This probability is low (for 
example, below a certain threshold, such as 0.05), so we conclude that it would 
be unusual for a negative reaction to the planned procedure to occur.

The threshold of an unusual event 
depends on the specific experiment; 
the 0.05 probability for an unusual 
event is not set in stone.

Higher probability values are associated with higher likelihood of occurrence. An 
outcome with probability 0.5 will happen about half of the time. An outcome with 
probability 0.95 is very likely. We say that an outcome or event is unusual if its prob-
ability is below a certain threshold, say, 0.05. 

YOUR TURN
 #1

For the following probabilities, determine the meaning of the indicated probability:

a. The stockbroker said that the chance for a recession was near zero.

b. The salesperson said that your chance of satisfaction with the purchase of a new 
car was 100%.

(The solutions are shown in Appendix A.)

NOW YOU CAN DO
Exercises 17–20.
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244 Chapter 5 Probability

Three methods for assigning probabilities are available:

● Classical method

● Relative frequency method

● Subjective method

We first take a close look at the classical method. Later in this section, we will examine 
the relative frequency method and the subjective method.

Many experiments are structured so that each experimental outcome is equally 
likely. Equally likely outcomes are outcomes that have the same probability of occur-
ring. For example, if you toss a fair coin, the probability of observing either of the 
outcomes—heads or tails—is the same. The classical method of assigning probabili-
ties is used when an experiment has equally likely outcomes.
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Did you know? People have been 
tossing dice for a long time. 
Archaeologists have dug up dice 
from Roman ruins looking just the 
same as ours. These three dice were 
uncovered from the ruins of Pompeii 
buried by the eruption of Mount 
Vesuvius in the first century A.D.

classical Method of Assigning Probabilities
Let N(E ) and N(S ) denote the number of outcomes in event E and the sample space S, 
respectively. If the experiment has equally likely outcomes, then the probability of event E is

PsEd 5
number of outcomes in E

number of outcomes in sample space
5

NsEd
NsSd

examPle 3  classical method: Single draw from a deck of cards

Find the probability of drawing an ace when drawing a single card at random from a 
deck of cards.

Solution
The sample space for the experiment in which a subject chooses a single card at random 
from a deck of cards is given in Figure 1. If the card is chosen truly at random, then it 
is reasonable to assume that each card has the same chance of being drawn. Each card 
is equally likely to be drawn, so we can use the classical method to assign probabilities.

FiGure 1
Sample space for drawing a card 
at random from a deck of cards.

A total of 52 outcomes are included in this sample space, so N(S ) = 52. Let E be 
the event that an ace is drawn. Event E consists of the four aces {A♥, A♦, A♣, A♠}, so 
N(E ) = 4. Therefore, the probability of drawing an ace is

PsEd 5
NsEd
NsSd

5
4

52
5

1

13

NOW YOU CAN DO
Exercises 21–24.
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2455.1 Introducing Probability

YOUR TURN
 #2

Find the probability of the following events when drawing a single card at random 
from a deck of cards:

a. a heart

b. a black card

(The solutions are shown in Appendix A.)

YOUR TURN
 #3

For the experiment in Example 4, find the following probabilities:

a. Not winning the game

b. Rolling a 5

(The solutions are shown in Appendix A.)

NOW YOU CAN DO
Exercises 25–30.

examPle 4  classical method: Single fair die

Recall the town fair example (page 240). In the game, you win if you roll a 6 on a 
single roll of a single fair die. Find the probability of winning the game.

Solution
The sample space for a single die toss consists of six outcomes, {1, 2, 3, 4, 5, 6}. 
When the six outcomes are equally likely, we say that the die is fair. If the outcomes 
are not equally likely, then the die is loaded or defective. If we assume the die is fair, 
then, because the sum of the probabilities of the n = 6 outcomes must equal 1, the 
probability of any particular outcome must equal 1/6, using the classical method.  
We write

probability of winning = P(W  ) = 1/6

Tree Diagrams
A tree diagram is a graphical display that allows us to list all the outcomes in the 
sample space of a multistage experiment. The next example shows how to construct a 
tree diagram.

examPle 5  List all outcomes in a sample space using a tree diagram

Suppose our experiment is to toss a fair coin twice.

a. Construct a tree diagram.

b. Use the tree diagram to list all the outcomes in the sample space.

Solution
a. Think of this experiment as a two-stage process:

● Stage 1: Toss the coin the first time.

● Stage 2: Toss the coin the second time.
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246 Chapter 5 Probability

Figure 2 shows the tree diagram for the experiment of tossing a fair coin twice. Note 
the branches for Stage 1: the first time the coin is tossed, it can come up heads or tails. 
At Stage 2, the tree diagram again has branches for either heads or tails.

b. The sample space for the experiment of tossing a coin twice is {HH, HT, TH, 
TT}. There are N(S) = 4 outcomes in the sample space. 

Heads, heads

Heads

Heads

Tails

Tails

Heads

Tails

Heads, tails

Tails, heads

Tails, tails

Stage 1:
Toss coin first time

Stage 2:
Toss coin second time

Outcomes

FiGure 2 Tree diagram for the experiment of tossing a fair coin twice.

YOUR TURN
 #4

Suppose our experiment is to toss a fair coin three times. 

a. Construct a tree diagram.

b. Use the tree diagram to list all the outcomes in the sample space.

(The solutions are shown in Appendix A.)

NOW YOU CAN DO
Exercises 31–38.

Note that two possible outcomes can occur at Stage 1 of this two-stage experiment 
and two possible outcomes when flipping the coin at Stage 2. To determine the number 
of outcomes in the entire experiment, the counting rule is simply to multiply the number 
of possible outcomes at each stage. In this two-stage experiment, 2 × 2 = 4 possible 
outcomes, which is the number of outcomes we see in the sample space.

examPle 6  classical method: Tossing a fair coin twice

Find the probability of obtaining one heads and one tails when a fair coin is tossed 
twice.

Solution
It is reasonable to assume that the N(S) = 4 outcomes in the sample space {HH, HT, 
TH, TT} are equally likely. The coin doesn’t remember what occurred at Stage 1, so 
the probabilities at Stage 2 are precisely the same as at Stage 1. Also, recall from the 
Law of Total Probability that the sum of the probabilities of all the outcomes in the 
sample space must equal 1. Thus, each of the four outcomes must have probability 1/4. 
Let E be the event that one heads and one tails is obtained. Then E = {HT, TH}, so 
N(E) = 2. Thus,

PsEd 5
number of outcomes in E

number of outcomes in sample space
5

NsEd
NsSd

5
2

4
5

1

2
NOW YOU CAN DO

Exercises 39–42.
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2475.1 Introducing Probability

Let E denote the event that your roommate rolls a sum equal to 4. Then the out-
comes that belong in this event are E: {(3,1) (2,2) (1,3)}, so N(E) = 3. The outcomes 
are equally likely, so we can use the classical method for finding probabilities of events.

PsEd 5
number of outcomes in E

number of outcomes in sample space
5

NsEd
NsSd

5
3

36
5

1

12

The probability that your roommate will land on Boardwalk on this throw of the dice 
is 1/12. 

YOUR TURN
 #5

For the experiment in Example 6, find the following probabilities:

a. Two heads

b. Two tails

(The solutions are shown in Appendix A.)

NOW YOU CAN DO
Exercises 43–50.

examPle 7  Finding probabilities for the experiment of tossing two fair dice
Imagine that you are playing Monopoly with your dormitory roommate, and the loser 
has to do the laundry for both of you for the rest of the semester. You have a hotel on 
Boardwalk, and if your roommate lands on it, you will surely win. Right now your 
roommate’s piece is on Short Line: if he or she rolls a 4, you will win and get your 
laundry done free for the remainder of the semester. Put into statistical terms, the 
experiment is to toss two fair dice and observe the sum of the two dice. Find the prob-
ability of rolling a sum of 4 when tossing two fair dice.

Solution
It is reasonable to assume that each of these N(S ) = 36 outcomes in the sample space 
(Figure 3) is equally likely. The experiment of tossing two dice can be viewed as a 
two-stage experiment, where we add the result from the first die to the result from 
the second die. If a 5 appears on the first (say, dark green) die, and a 3 appears on the 
second (light green) die, the overall outcome is (5,3), with the resulting sum equal to 8. 
Note that the outcome (5,3) is not the same as the outcome (3,5), where the dark green 
die comes up 3 and the light green die comes up 5.
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C
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FiGure 3 Sample space for tossing two fair dice.

YOUR TURN
 #6

For the experiment in Example 7, find the following probabilities:

a. Rolling a sum of 7 with the two dice

b. Rolling boxcars (sum of 12 with the two dice)

c. Rolling snake eyes (sum of 2 with the two dice)

(The solutions are shown in Appendix A.)

Larose_3e_ch05.indd   247 16/06/15   5:13 PM



© 20
16

 W
.H. F

ree
man

 Co.

248 Chapter 5 Probability

relative Frequency Method
In Example 4, we need the classical method to find that the probability of rolling a 6 
with a fair die is 1/6. What does this probability mean? Remember that the definition 
of probability included the phrase “long-term proportion.” The next example demon-
strates what we mean by “long-term.”

3

examPle 8   inappropriate use of the classical method

Watch a lot of YouTube? Hate the in-stream ads? According to Social Strand Media, 
75% of in-stream ads are skippable (www.slideshare.net/SocialStrand/social-media 
-stats-2014). Suppose we choose one in-stream ad at random. Define the following events:

C: The randomly chosen in-stream ad is skippable.

D : The randomly chosen in-stream ad is not skippable.

Determine whether the classical method can be used to assign probability to events C 
and D.

Solution
Because more than half of in-stream ads are skippable, if we choose one at random, we 
are more likely to find a skippable one than a non-skippable one. Therefore, the events 
C and D are not equally likely. It would be inappropriate to use the classical method 
of assigning probabilities for this experiment because the classical method can be used 
only when all the outcomes of an experiment are equally likely. 

The proper method for solving this 
problem is the relative frequency 
method, which we discuss next.

examPle 9  Simulating the long-term proportion of 6s in a fair die roll

Suppose we want to investigate the proportion of 6s we observe if we roll a fair die  
100 times. We can use technology, such as the TI-83/84 used here, to help us simulate 
rolling a fair die a large number of times. A simulation uses methods such as rolling 
dice or computer generation of random numbers to generate results from an experiment. 
The actual die rolls from our simulation are shown here, in order, with the 6s in boldface.

1 4 4 6 2 4 3 2 1 3 4 3 3 4 3 3 6 3 5 5 1 5 3 5 5 2 1 3 1 1 1 5 5 6 3 6 2 1 6 5 5 4 4 6 5 4 1 1 4 6

4 2 2 2 6 3 2 5 5 6 1 1 3 1 6 5 4 6 6 5 5 5 2 5 5 3 4 2 4 6 4 5 5 1 6 3 1 1 1 3 5 4 2 3 3 3 6 2 5 3 

Thus, the first die roll was a 1, so the proportion of 6s was 0/1. The second and third 
die rolls were 4s, so the proportion of 6s after 3 rolls was 0/3. On the fourth roll, a 
6 appeared, so the proportion of 6s after the fourth roll was 1/4. Figure 4 provides a 
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FiGure 4 Proportion of 6s, 100 die rolls.
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2495.1 Introducing Probability

graph of the proportion of 6s in this simulation as the number of die rolls increased. 
Note that as the number of die rolls increases, the proportion of 6s tends to get closer 
to the horizontal line: 0.1667 ≈ 1/6.

The simulation was rerun—this time with 1000 die rolls. The resulting graph of 
the proportion of 6s is provided in Figure 5. Note that as the number of die rolls 
increases, the proportion of 6s approaches the line 0.1667 ≈ 1/6, and the fit is tighter 
with 1000 die rolls than with 100. This is what we mean by “long-term proportion.” 
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FiGure 5 Proportion of 6s, 1000 die rolls.

This example leads directly to the following law.

The Law of Large Numbers for Proportions applet allows you to simulate coin tossing 
and observe the proportion of heads as the number of tosses increases.

Law of Large Numbers
As the number of times that an experiment is repeated increases, the relative frequency 
(proportion) of a particular outcome tends to approach the probability of the outcome.
● For quantitative data, as the number of times that an experiment is repeated increases, 

the mean of the outcomes tends to approach the population mean.
● For categorical (qualitative) data, as the number of times that an experiment is repeated 

increases, the proportion of times a particular outcome occurs tends to approach the 
population proportion.

relative Frequency Method
If we can’t use the classical method for assigning probabilities, then the Law of Large 
Numbers gives us a hint about how we can estimate the probability of an event. It  
often happens that previous information is available about the relative frequency of  
an event. Relative frequency information can be used to estimate the probability of  
the event.

relative Frequency Method of Assigning Probabilities
The probability of event E is approximately equal to the relative frequency of event E.  
That is,

PsEd < relative frequency of E 5
frequency of E

number of trials of experiment

The relative frequency method is also known as the empirical method.

Note: Tree diagrams can be used 
for the relative frequency method 
as well as the classical method of 
assigning probability.

Note: The relative frequency 
method may be used when previous 
information is available about the 
relative frequency of an event.
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250 Chapter 5 Probability

examPle 10  relative frequency method

examPle 11  Probability models based on frequency tables

case  
sTudy

The Gardasil vaccine
The Case Study data set Gardasil provides the following relative frequency 
distribution for the variable Completed, indicating whether or not the patient 

completed the course of three Gardasil vaccinations. Use the relative frequency method 
to find the probability that a randomly chosen patient completed the treatment.

Completed Frequency Relative frequency

Yes  469 0.3319

No  944 0.6681

Total 1413 1.0000

Solution
Define the event.

C: Patient completed treatment.

We use the relative frequency method to find the probability of event C:

PsCd < relative frequency of C 5
frequency of C

number of trials in experiment
5

469

1413
< 0.3319

YOUR TURN
 #7

Using the experiment from Example 10, do the following:

a. Use a capital letter to define the event that a patient did not complete the 
treatment.

b. Find the relative frequency of your event from (a). 

c. Assign your relative frequency from (b) as the probability that a patient did not 
complete the treatment.

(The solutions are shown in Appendix A.)

NOW YOU CAN DO
Exercises 51–60.

We can also use the relative frequency method to build a probability model with 
data that have been summarized in a table.

Table 2 contains the employment type for a sample of 1000 employed citizens of Fair-
fax County, Virginia.3 Use the data to construct the probability model by generating the 
relative frequencies and using the relative frequencies to estimate the probabilities for 
each employment type. 

Table 2 Employment types

Employment type Count

Private company 597

Federal government   141

Self-employed  97

Private nonprofit  92

Local government  59

State government  12

Other   2
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2515.1 Introducing Probability

Solution
We calculate the relative frequencies of each employment group by dividing the count 
(frequency) for each group by the sample size 1000. For example, the relative fre-
quency for “Private Company” is 597

1000 5 0.597. The relative frequency is then used to 
estimate the probability of selecting citizens who work at private companies in Fairfax 
County, Virginia. Filling in the remaining calculations produces the probability model 
in Table 3. Note that the table follows the Rules of Probability in that (a) each outcome 
has probability between 0 and 1, and (b) the sum of the probabilities of all the out-
comes equals 1.0.

examPle 12  random draws using a probability model

NOW YOU CAN DO
Exercises 61 and 62.

fairfaxemploy

Table 3 Probability model

Employment type Probability

Private company 0.597

Federal government 0.141

Self-employed 0.097

Private nonprofit 0.092

Local government 0.059

State government 0.012

Other 0.002

Suppose we consider the probabilities in Table 3 as population values. Use technology 
to simulate random draws using the probability model in Table 3.

Solution
Using the Step-by-Step Technology Guide on page 252, we drew samples of sizes 10, 
100, 1,000, and 10,000 from the probability model in Table 3. The results are shown 
in Table 4.

Table 4 Relative frequencies from random draws of different sizes

Employment type
Rel freq 
n 5 10

Rel freq 
n 5 100

Rel freq 
n 5 1,000

Rel freq 
n 5 10,000

Private company 0.60 0.62 0.566 0.596

Federal government 0.20 0.15 0.15 0.143

Self-employed 0.10 0.11 0.109 0.991

Private nonprofit 0.10 0.07 0.106 0.914

Local government 0.00 0.04 0.055 0.056

State government 0.00 0.01 0.012 0.012

Other 0.00 0.00 0.002 0.002

Note that each relative frequency tends to approach its respective probability as 
the sample sizes grow larger. 

Subjective method for assigning probability
Some cases have outcomes that are not equally likely (so the classical method 
does not apply) and there has been no previous research (so the relative frequency 
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approach does not apply). For example, what is the probability that the Dow Jones 
Industrial Average will decrease today? In cases like this, there is no absolutely 
correct probability. Reasonable people can disagree reasonably over these prob-
abilities. The idea is to consider all available information, tempered by our experi-
ence and intuition, and then assign a probability value that expresses our estimate 
of the likelihood that the outcome will occur. Finally, it should be noted that 
the subjective method should be used when the event is not (even theoretically) 
repeatable.

Subjective probability refers to the assignment of a probability value to an outcome 
based on personal judgment.

A financial analyst is interested in the probability that the Dow Jones Industrial 
Average will go down today. Suppose the Chairman of the Federal Reserve warned 
against inflation in a major speech yesterday. How would the financial analyst use 
this information to subjectively assign the probability that the stock market will go 
down today?

Solution
Through long professional experience, the financial analyst has seen the Dow go 
down—often, the day after speeches by the Federal Reserve Chairman warning against 
inflation. She therefore assigns a subjective probability that the probability the Dow 
Jones Industrial Average will go down today is 75%. Although the exact subjective 
probability assigned by other financial analysts may differ somewhat, most will prob-
ably share the opinion that the Dow will decrease today.

examPle 13  Subjective method for assigning probability

STeP-By-STeP TechNOLOGy GuiDe: Probability Simulations using Technology

TI-83/84
Simulating 100 Die Rolls
Step 1 Set the random number seed as follows. (The random 
number seed is a number that the calculator uses to generate 
random numbers.) Enter any number on the home screen. Press 
STO , then MATH, highlight PRB, select 1: rand, and press 
ENTER. On the home screen press ENTER.
Step 2 Press MATH, highlight PRB, select 5: randInt(, and press 
ENTER.
Step 3 Enter 1, comma, 6, comma, 100, close parenthesis 
(Figure 6).
Step 4 Store the data in list L1 as follows. Press STO , then 
2nd, then 1, then press ENTER.
Step 5 To examine the die rolls, press STAT, select 1: EDIT, and 
press ENTER (Figure 7). FiGure 6 FiGure 7

EXCEL
Simulating 100 Die Rolls
Step 1 Select cell A1. Click the Insert Function icon fx.
Step 2 For Search for a Function, type randbetween, click Go, 
then click OK.

Step 3 For Bottom, enter 1. For Top, enter 6 (Figure 8). Click 
OK. Cell A1 now contains a simulated random die roll.
Step 4 Select cell A1, copy it, and paste the contents into cells 
A2 through A100.

Simulating Coin Flips
You can simulate coin flips instead of die rolls by coding “heads” 
as 1 and “tails” as 0. Use the instructions for simulating 100 die 
rolls with the following changes: Enter 0, comma, 1, comma, 
100, close parenthesis, so that the home screen shows randInt(0, 
1, 100).
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FiGure 8 Random die rolls in Excel.

Simulating the Sum of Two Dice
Step 1 Generate 100 die rolls in column A and another 100 
die rolls in column B.
Step 2 Select cell C1. Enter =(A1+B1), and press ENTER.
Step 3 Select cell C1, copy it, and paste the contents into cells 
C2 through C100. Column C then represents 100 randomly 
generated sums of two dice.

Simulating Random Draws from a Probability Table
We illustrate using Example 11 (page 250). Excel requires that 
the categories in the probability model be coded as numeric. 
We therefore code “Private company” as 1, “Federal 
government” as 2, and so on.
Step 1 Type the model categories (for example, “Employment 
type”) in column A, their numeric codes in column B, and the 
respective probabilities in column C.
Step 2 Click Data > Data Analysis > Random Number 
Generation, then OK.
Step 3 For Number of Variables, enter 1.
Step 4 For Number of Random Numbers, enter the desired 
sample size.
Step 5 For Distribution, select Discrete.
Step 6 For Value & Probability Input Range, click and drag to 
select the coded categories and their probabilities, for example, 
B1:C7. Click OK.

Repeat Steps 1–6 for increasing sample sizes.
Simulating Coin Flips
You can simulate coin flips instead of die rolls by coding “heads” 
as 1 and “tails” as 0. Use the die roll instructions with the 
following changes: For Bottom, enter 0. For Top, enter 1.

MINITAB
Simulating 100 Die Rolls
Step 1 Click on Calc > Random Data > Integer…
Step 2 For Number of rows of data to generate, enter 100.
Step 3 For Store in column(s), type C1.
Step 4 For Minimum value, enter 1. For Maximum value, enter 6.
Step 5 Click OK.

Simulating the Sum of Two Dice
Step 1 Generate 100 die rolls in C1 and another 100 die rolls 
in C2.
Step 2 Click Calc > Calculator. For Store result in variable, 
enter C3. For Expression, enter C1 + C2. Click OK. Column C3 
then represents 100 randomly generated sums of two dice.

Simulating Random Draws from a Probability Table
We illustrate using Example 11 (page 250). Minitab requires that 
the categories in the probability model be coded as numeric. 
We therefore code “Private company” as 1, “Federal 
government” as 2, and so on.
Step 1 Type the model categories in C1, their numeric codes in 
C2, and the respective probabilities in C3 (Figure 9).
Step 2 Click on Calc > Random Data > Discrete…
Step 3 For Number of rows of data to generate, enter the 
desired sample size.
Step 4 For Store in column(s), select the next available column, 
such as C4.
Step 5 For Values in, enter the column with the numerically 
coded categories, such as C2.

FiGure 9 Random draws in Minitab.

Step 6 For Probabilities in, enter the column with the 
probabilities, such as C3.
Step 7 Click OK.

Repeat Steps 1–7 for increasing sample sizes, as shown in Figure 9.

Simulating Coin Flips
You can simulate coin flips instead of die rolls by coding “heads” as 
1 and “tails” as 0. Use the die roll instructions with the following 
changes: For Minimum value, enter 0. For Maximum value, enter 1.

SPSS
Simulating 100 Die Rolls
Step 1 Select the header of the first column, and click Edit > 
Insert Variable. Highlight between 1 and 30 rows and click Edit > 
Insert Cases. More cases can be added by selecting more rows 
and choosing Edit > Insert Cases again.
Step 2 Go to Variable View. Name the first column Roll1.
Step 3 Click Transform > Compute Variable…. For Target 
Variable, put Roll1. Click in the Numeric Expression box, then 

under Function Group click Arithmetic, and under Functions  
and Special Variables double-click Rnd(1).
Step 4 Under Function Group, click Random Numbers,  
and under Functions and Special Variables double-click 
Rv.Uniform. Replace the two question marks in Numeric 
Expression with 1 and 6, as shown in Figure 10. Click OK  
and OK. Minimize the output window. The die rolls can be 
seen in the Data View tab.
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Simulating the Sum of Two Dice
Step 1 Select the header of the first column, and click Edit > Insert 
Variable. Repeat for the second and third column. Highlight between 
1 and 30 rows, and click Edit > Insert Cases. More cases can be 
added by selecting more rows and choosing Edit > Insert Cases 
again.
Step 2 Go to Variable View. Name the first column Roll1, the 
second column Roll2, and the third column SumRolls.
Step 3 Generate 100 die rolls in Roll1 and another 100 die 
rolls in Roll2.
Step 4 Click Transform > Compute Variable. For Target 
Variable, put SumRolls. Click inside the Numeric Expression box, 
then double-click Roll1, click the plus sign, and double-click Roll2. 
Click OK and OK, and minimize the output window.

Simulating Coin Flips
You can simulate coin flips instead of die rolls by coding “heads” 
as 1 and “tails” as 0. Use the die roll instructions with the following 
changes: replace the two question marks with 0 and 1.

JMP
Simulating 100 Die Rolls
Step 1 Click File > New > Data Table. Click Rows > Add 
Rows…, and enter 100 rows.
Step 2 Select Column 1. Click Cols > Formula…. In the list 
under Functions(grouped), select Random > Random Integer.
Step 3 In the formula, replace n1 with 1,6, so the formula is 
Random Integer(1,6). Click OK.

Simulating the Sum of Two Dice
Step 1 Generate 100 die rolls in Column 1 and another 100 
rolls in Column 2.
Step 2 Doubleclick the header of the third column, and select 
Column 3. Click Cols > Formula…. Select Column 1, the plus 
sign, then Column 2, as in Figure 11. Click OK.

Simulating Coin Flips
You can simulate coin flips instead of die rolls by coding “heads” 
as 1 and “tails” as 0. Use the die roll instructions, but change the 
formula to Random Integer(0,1).

Section 5.1 Summary
 1. Section 5.1 introduces the building blocks of 
probability, including the concepts of probability,  
outcome, experiment, and sample space. Probabilities 
always take values between 0 and 1, where 0 means that  
the outcome cannot occur and 1 means that the outcome is 
certain.
 2. The classical method of assigning probability is used if 
all outcomes are equally likely. The classical method states 
that the probability of an event A equals the number of 

Section 5.1 Exercises
ClarifyinG the ConCepts

 1. Describe in your own words how chance and uncertainty 
affect you in your life. List some synonyms that we use in 
everyday life for the word probability. (p. 240)

outcomes in A divided by the number of outcomes in the 
sample space.
 3. The Law of Large Numbers states that, as an experiment 
is repeated many times, the relative frequency (proportion) of 
a particular outcome tends to approach the probability of the 
outcome. The relative frequency method of assigning 
probability uses prior knowledge about the relative frequency 
of an outcome. The subjective method of assigning 
probability is used when the other methods are not applicable.

 2. Why do you think we use numerical values for 
probability instead of only qualitative terms such as “likely” 
or “impossible”? (p. 242)
 3. Give three examples from your own life of experiments, 
as the term is used in this chapter. (p. 241)
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a. For each experiment, what are some of the outcomes?
b. Write out the sample space of one of these experiments.
c. Describe how the Law of Total Probability applies to 

the sample.
 4. List the three methods for assigning probabilities. (pp. 243, 
248, 251)
 5. What assumption do we need to make to use the 
classical method? (p. 244)
 6. When can we use the relative frequency method? (p. 249)
 7. If we can’t use either the classical method or the relative 
frequency method, explain how we go about using the 
subjective method. (p. 252)
 8. The experiment is to toss 10 fair coins 25 times each. Which 
methods can we use to assign probabilities? (pp. 243, 248)
 9. How would you find the probability that a randomly 
chosen student at your college likes hip-hop music? What 
method would you use? (p. 248)
10. Describe the meaning of the following probabilities:  
(p. 242)

a. Near 0
b. 0
c. Near 1
d. 1

praCtiCinG the teChniques

• CheCK it out!

to do Check out topic

Exercises 11–16 Example 1 Probability models

Exercises 17–20 Example 2 Determining unusual or 
likely outcomes

Exercises 21–24 Example 3 Single draw from deck of 
cards

Exercises 25–30 Example 4 Single fair die

Exercises 31–38 Example 5 Tree diagrams and 
sample space

Exercises 39–42 Example 6 Tossing a fair coin twice

Exercises 43–50 Example 7 Tossing two fair dice

Exercises 51–60 Example 10 Relative frequency method.

Exercises 61–62 Example 11 Probability models based 
on frequency tables

Determine whether each table in Exercises 11–16 is a probability 
model. If not, clearly explain why it is not a probability model.
11. Customers at a clothing store at the mall

Gender probability

Females 1.1

Males –0.2

12. Singers in the church choir

Voice probability

Soprano  0.50
Alto  0.25
Tenor –0.25
Bass  0.25

13. Voters at a town meeting

party probability

Democrat 0.25
Republican 0.25
Independent 0.3
Green 0.1
Libertarian 0.1
Other 0.1

14. Majors of students taking introductory statistics

Major probability

Business 0.50
Nursing 0.20
Social sciences 0.20
Science 0.20
Math 0.10

15. Students taking undergraduate introductory statistics

Class probability

Freshmen 0.15
Sophomores 0.25
Juniors 0.40
Seniors 0.20

16. Reasons why Hurricane Katrina survivors did not 
evacuate

reason probability

I did not have a car or a way to leave. 0.36

I thought the storm and its aftermath 
would not be as bad as they were.

0.29

I just didn’t want to leave. 0.10

I had to care for someone who was 
physically unable to leave.

0.07

All other reasons 0.18

For the probabilities in Exercises 17–20, determine the 
meaning of the indicated probability.
17. The doctor said the chances of recovery from the 
surgery were near 100%.
18. The parent said that, if the student’s grades did not 
improve, there was no chance of getting the new video game 
system for a birthday present.
19. The stockbroker said the chances were high that the 
blue chip stock would gain in value this year.
20. The political analyst gloomily told the candidate that his 
chances of winning the election were about 2%.

For Exercises 21–24, the experiment is to draw a card at 
random from a shuffled deck of 52 cards. Find the following 
probabilities:
21. Drawing a jack
22. Drawing a club
23. Drawing the jack of clubs
24. Drawing a red card

2555.1 Introducing Probability
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For Exercises 25–30, the experiment is to roll a fair die once. 
Find the following probabilities:
25. Observing a 2
26. Observing an odd number
27. Observing a number greater than 2
28. Observing a number less than 2
29. Observing a 2 or a 3
30. Observing a 2 and a 3

For Exercises 31 and 32, consider the experiment of tossing 
a fair die two times, with the outcomes being the observation 
of either an even number or an odd number.
31. Construct a tree diagram for the experiment.
32. Construct the sample space for the experiment.

For Exercises 33 and 34, let the experiment be tossing a fair 
die two times, with the outcomes being observing either a 
number less than 4 or a number greater than or equal to 4.
33. Construct a tree diagram for the experiment.
34. Construct the sample space for the experiment.

For Exercises 35–38, consider the experiment of tossing a 
fair coin three times and observing either heads or tails.
35. Construct a tree diagram for the experiment.
36. Construct the sample space for the experiment.
37. How does the tree diagram help to construct the sample 
space?
38. How do we find each outcome using the tree diagram?

For Exercises 39–42, consider the experiment of tossing a 
fair coin twice.
39. Find the probability of observing zero heads.
40. Find the probability of observing exactly one head.
41. Find the probability of observing two heads.
42. Use your results from Exercises 39–41 to construct the 
probability model for the number of heads observed when 
tossing a fair coin twice.

For Exercises 43–50, consider the experiment of tossing two 
fair dice and observing the sum of the two dice. (Hint: Use 
the sample space in Figure 3 on page 247.)
43. What is the probability that the sum of the dice equals 9?
44. Find the probability that the dark green die equals 9.
45. Calculate the probability that the sum of the dice equals 11.
46. Find the probability that the light green die equals 5.
47. What is the probability that the sum of the dice equals 1?
48. Construct the probability model for the sum of the dice.
49. Use the probability model to find which event has the 
greatest probability.
50. Which events have the lowest probability?

For Exercises 51−56, suppose that, in a sample of 100 
students who drink hot caffeinated beverages, 35 preferred 
regular coffee, 20 preferred latte, 20 preferred cappuccino, 
and 25 preferred tea. Find the probability that a randomly 
selected student prefers the following:
51. Regular coffee
52. Latte
53. Cappuccino
54. Tea
55. For Exercises 51−54, which method of assigning 
probability are you using?

56. Construct the probability model for hot caffeinated 
beverages.

For Exercises 57−60, suppose that, in a sample of 200 college 
students, 80 live on campus, 80 live with family off campus, 
and 40 live in an apartment off campus. Find the probability 
that a randomly selected student lives in the following places:
57. On campus
58. With family off campus
59. In an apartment off campus
60. Construct the probability model for where these 
students live.
61. Use the following frequency table to estimate the 
probabilities for each color and construct the probability 
model. A sample of 100 students was asked to name their 
favorite color.

favorite color frequency

Red 25
Blue 25
Green 20
Black 10
Violet 10
Yellow 10

62. Use the following frequency table to estimate the 
probabilities for each season and construct the probability 
model. A sample of 200 students was asked to name their 
favorite season.

favorite season frequency

Summer 70
Spring 70
Autumn 50
Winter 10

applyinG the ConCepts
63. technology adopters. The Gallup organization 
published a study4 in which they categorized American 
technology adopters as either Super Tech Adopters (31%), 
Smart Phone Reliants (19%), Mature Technophiles (22%), or 
Tech-Averse Olders (28%). Consider the experiment of two 
American technology adopters at random.

a. Construct the tree diagram for the experiment.
b. What is the sample space?

64. facebook females and Males. The Facebook Social 
Ads Platform reported the following number of users in the 
United States in 2014, by gender: females: 96 million, 
males: 82 million, unknown: 2 million. 

a. Construct a relative frequency distribution.
b. Use the relative frequency method to assign 

probabilities to each outcome. 
c. Consider the experiment of choosing three Facebook 

users at random. Construct the tree diagram for the 
experiment.

d. What is the sample space for the experiment in (c)?
65. owning a time Machine. The Pew Research Internet 
Project reported that 14 of the 144 people ages 18–29 that it 
surveyed would someday like to own a time machine.5 
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2575.1 Introducing Probability

a. What is the probability that a randomly chosen 18- to 
29-year-old would someday like to own a time 
machine?

b. What is the probability that a randomly chosen 18- to 
29-year-old would not someday like to own a time 
machine?

c. Which method of assigning probability did you use?
66. Basketball. Your college’s basketball team is playing a 
game next week.

a. What is the probability that the team will win the game?
b. Which method did you use?

67. Brisbane Babies. The table shows the births of babies 
at a Brisbane, Australia, hospital on a particular day.6

Girl Girl Boy Boy Boy Girl Girl Boy Boy
Boy Boy Boy Girl Girl Boy Girl Girl Boy
Boy Boy Boy Girl Girl Girl Girl Boy Boy 
Boy Girl Boy Girl Boy Boy Boy Boy Boy 
Girl Boy Boy Boy Boy Girl Girl Girl

a. Construct a relative frequency distribution of the 
numbers of girls and boys born.

b. Use the relative frequencies to construct a probability 
model.

c. Confirm that your probability model follows the 
Rules of Probability.

68. Draw an ace. If you draw the ace of spades from a 
deck of cards, you win $200.

a. What is the probability of winning this game?
b. What would be a fair price for playing this game? 

(Hint: A fair price might be determined by balancing 
out the winnings and the price in the long run.)

69. a Bazaar Game. Lenny has gone to the church bazaar 
with his family. In one of the games at the bazaar, if Lenny 
rolls two dice and gets a sum of at least 10, he wins $10; 
otherwise, he wins nothing.

a. Find the probability of winning $10.
b. Find the probability of winning nothing.
c. What would you suggest would be a fair (break-even) 

price for playing this game?
70. sharing social Media profiles. The Pew Research 
Center reported that 98 of the 889 social media users in 
committed relationships that it surveyed shared a social 
media profile with their partners.7

a. Explain whether or not you can use the classical method 
of assigning probability to find the probability of 
sharing a social media profile with a partner, and why.

b. Find the probability that a social media user in a 
committed relationship shares a social media profile 
with his or her partner. Which method did you use?

For Exercises 71−75, consider the experiment of tossing a 
fair coin three times and observing either heads or tails.
71. Find the probability of zero heads.
72. What is the probability of exactly one head?
73. Calculate the probability of exactly two heads.
74. Find the probability of exactly three heads.
75. Use your results from Exercises 71−74 to construct a 
probability model for the number of heads observed.

76. For Exercises 71−74, which method of assigning 
probability are you using?

For Exercises 77–80, consider the experiment of tossing a 
fair coin three times. Find the indicated probabilities. (Hint: 
Use a tree diagram similar to the one on page 246, but add 
one more stage.)
77. Observing 3 heads
78. Not observing 3 heads
79. Observing 2 tails
80. Not observing 2 tails
81. fairfax County income. The following table contains a 
probability model for the distribution of income in Fairfax 
County, Virginia. fairfaxincome

a. Use technology to draw random samples of sizes 10, 
100, 1,000, and 10,000 from this probability model.

b. What can you conclude about the relative frequencies 
as the sample size increases?

annual income probability

Under $25,000 0.083
$25,000 to $49,999 0.166
$50,000 to $74,999 0.169
$75,000 to $99,999 0.160
$100,000 to $149,999 0.200
$150,000 or more 0.222

teenagers’ Music and lifestyle. Every year, USA Weekend 
conducts a survey of the nation’s teenagers, asking them 
various questions about lifestyle and music. Nearly 60,000 
teenagers responded to the survey, conducted in part through 
a Web site. Use this information for Exercises 82 and 83.
82. One USA Weekend survey question asked teenagers, 
“Do you listen to music while you are . . .?” and listed 
several options. The most common responses are shown in 
the table. Respondents could choose more than one 
response. Explain why you cannot construct a probability 
model with these percentages.

Doing chores 79%
On the computer 73%
Doing homework 72%
Eating meals at home 33%
In the classroom 18%

83. Another survey question asked by USA Weekend was 
“If you had to choose just one type of music to listen to 
exclusively, which would it be?” The results are shown in the 
table. teenmusic

Hip-hop/rap 27%
Pop 23%
Rock/punk 17%
Alternative 7%
Christian/gospel 6%
R&B 6%
Country 5%
Techno/house 4%
Jazz 1%
Other 4%
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258 Chapter 5 Probability

a. Construct a probability model.
b. Is it unusual for a respondent to prefer jazz?
c. Use technology to draw random samples of sizes 

10, 100, 1,000, and 10,000 from your probability 
model.

d. What can you conclude about the relative frequencies 
as the sample size increases?

84. paul the predicting octopus. During the 2010 World 
Cup, Paul the Octopus picked the correct outcome of each 
soccer match in which Germany was involved, and then he 
continued his winning streak right to the end, picking 
champion Spain in the final match. Paul indicated his choice 
by swimming over and choosing one of two containers of 
mussels (his favorite food). Each container had the flag of a 
country in the day’s match. Paul predicted the outcome 
correctly eight times in a row.

a. Find the probability of Paul predicting all eight 
matches correctly, assuming a success probability of 
50% for each match. Express this answer in the form 
(1/2)k, where k is the number of matches.

b. Let’s say that Paul had predicted nine matches in a 
row correctly. Find the probability of doing so, 
assuming 50% probability of success for each match. 
Express this answer in the form (1/2)k.

c. What is the ratio of your results from (b) to your 
results from (a)?

d. Use your results from (a)–(c) to form a general rule 
for the probability of correctly predicting k matches 
in a row when the probability of success for each 
match is 50%.

what if

?
85. Refer to the previous exercise. What if the 
probability of Paul predicting correctly was larger 
than 50%? Would your answers to the following be 

greater or less than what you calculated in the previous 
exercise?

a. The probability of Paul predicting all eight matches 
in a row correctly

b. The probability of Paul predicting nine matches in a 
row correctly

Use the following information for Exercises 86–91. Consider 
the experiment where a fair die is rolled twice. Define the 
following events for each roll: low = {1, 2}, medium =  
{3, 4}, high = {5, 6}, odd = {1, 3, 5}, even = {2, 4, 6}.
86. Construct a tree diagram for this experiment. Make sure 
you use the outcomes and not the events.
87. Use the tree diagram to construct the sample space.  
To which sample space discussed in Section 5.1 is the 
sample space for this experiment similar? Explain why 
this is so.
88. The sample space is the collection of all possible 
outcomes of an experiment. Explain why the sample space 
is not defined as the collection of all possible events.
89. Find the probability of observing a 1, followed by 
another 1. What method of assigning probability are you 
using? Why?
90. Find the probability of observing two high die rolls. 
What method of assigning probability are you using? Why?

91. Find the following probabilities:
a. Two high die results
b. Exactly one medium die result
c. No low die results
d. At least one high die result
e. At most one medium die result

BrinGinG it all toGether

Best-selling Video Games. Table 5 contains the top 20 
best-selling video games in the United States for the week of 
May 17, 2014, along with the game platform, publishing 
studio, and the type of game. Use this information for 
Exercises 92–98.

taBle 5 top 20 best-selling video games in the 
united states for the week of May 17, 2014

Game/platform studio type

Minecraft for PS3 Sony Adventure
Minecraft for Xbox 360 MS Adventure

Kirby: Triple Deluxe for 3DS Nintendo Platform

MLB 14 The Show for PS4 Sony Sports

Titanfall for Xbox One Electronic 
Arts

Shooter

Call of Duty: Ghosts for Xbox 
360

Activision Shooter

Bound by Flame for PS4 Focus Action

Pokemon X/Y for 3DS Nintendo Role-
playing

Titanfall for Xbox 360 Electronic 
Arts

Shooter

Grand Theft Auto V for Xbox 
360

Take-Two Action

Grand Theft Auto V for PS3 Take-Two Action

Call of Duty: Ghosts for PS4 Activision Shooter

Super Luigi U for WiiU Nintendo Platform

Super Mario Brothers U for 
WiiU

Nintendo Action

Call of Duty: Ghosts for PS3 Activision Shooter

Borderlands 2 for PSV Take-Two Shooter

Battlefield 4 for Xbox 360 Electronic 
Arts

Shooter

Forza Motorsport 5 for Xbox 
One

MS Racing

Call of Duty: Ghosts for Xbox 
One

Activision Shooter

inFamous: Second Son for PS4 Sony Action

92. Suppose our experiment is to select one video game at 
random from Table 5 and observe its studio. What are the 
possible outcomes of this experiment?
93. Find the probability that the video game studio is Sony.
94. Continue to find the probability of each outcome in 
Exercise 93. Combine these to construct the probability 
model for this experiment. Which method of assigning 
probability did you use?
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 95. Verify that your probability model in Exercise 94 
meets the Rules of Probability.
 96. Next, suppose our experiment is to select, at random, two 
video games in succession and to observe the type of game.

a. Construct a tree diagram for this experiment.
b. Use the tree diagram to generate the sample space.

 97. Construct a relative frequency distribution of the type 
of game.
 98. Use your relative frequency distribution from  
Exercise 97 to construct a probability model of type. Verify 
that your probability model meets the Rules of Probability.

Use the Law of Large Numbers for Proportions applet for 
Exercises 99 and 100.
 99. Set the probability of heads to 0.5 and the number of 
tosses to 40. Click toss.

a. Record the proportion of heads observed.
b. Without pressing reset, continue to click toss until 

the total number of tosses is 120. Again, record the 
proportion of heads.

c. Without pressing reset, continue to click toss until 
the total number of tosses is 240. Again, record the 
proportion of heads.

d. Without pressing reset, continue to click toss until 
the total number of tosses is 480. Again, record the 
proportion of heads.

100. The proportions you recorded in Exercise 99 are 
relative frequencies of heads. What can you conclude about 
the relative frequencies as the sample size increases?

WorKinG With larGe Data sets

case  
sTudy

Chapter 5 Case study: the Gardasil Vaccine. 
Open the data set Gardasil. We shall explore some 
probabilities about clinic location and patient 
insurance type, using the tools and techniques  

we have learned in this section. Use technology to do 
Exercises 101–106. gardasil

101. Construct a frequency distribution of the variable 
Clinic Location.
102. Use the frequency distribution from Exercise 101 to 
construct a probability model for the location of the clinic.
103. What is the probability that a randomly chosen clinic 
will be urban? What method are you using to assign this 
probability?
104. Construct a frequency distribution of the variable 
Insurance Type.
105. Use the frequency distribution from Exercise 104 to 
construct a probability model for type of insurance.
106. What is the probability that a randomly chosen patient 
will have a private payer insurance type? What method are 
you using to assign this probability?

5.2 Combining Events

OBjecTiveS By the end of this section, I will be able to . . .
1 Combine events using complement, union, and intersection.
2 Apply the Addition Rule to events in general and to mutually exclusive events 

in particular.

complement, union, and intersection
In Example 7, if your roommate rolled a 4, then your roommate was to do your laundry 
for the rest of the semester. Your roommate is keenly interested in not rolling a 4. If A 
is an event, then the collection of outcomes not in event A is called the complement of 
A, denoted AC. The term complement comes from the word “to complete,” meaning 
that any event and its complement together make up the complete sample space.

1

examPle 14 Finding the probability of the complement of an event
If A is the event “observing a sum of 4 when the two fair dice are rolled,” then your 
roommate is interested in the probability of AC, the event that a sum of 4 is not rolled. 
Find the probability that your roommate does not roll a sum of 4.

Solution
Which outcomes belong to AC? By the definition, AC is all the outcomes in the sample 
space that do not belong in A. The following outcomes are included in A: {(3,1), (2,2), 
(1,3)}.

2595.2 Combining Events
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260 Chapter 5 Probability

Figure 12 shows all the outcomes, except the outcomes from A in the two-dice 
sample space. There are 33 outcomes in AC and 36 outcomes in the sample space. 
The classical probability method then gives the probability of not rolling a sum of 4 
to be

PsACd 5
NsACd
NsSd

5
33

36
5

11

12

FiGure 12 Outcomes in AC.

YOUR TURN
 #8

Refer to the two-dice sample space on page 247. Define event B as rolling a sum  
of 8.

a. Find P(B).

b. Calculate P(BC ).

(The solutions are shown in Appendix A.)

NOW YOU CAN DO
Exercises 7–12.

Probabilities for complements
For any event A and its complement AC, P (A) 1 P (AC) 5 1. Applying a touch of algebra 
gives the following:

● P (A) 5 1 2 P (AC)
● P (AC) 5 1 2 P (A)

Sometimes we need to find the probability of a combination of events. For exam-
ple, consider the casino game of craps in which you roll two dice. One way of winning 
is by rolling the sum 7 or 11. We can find the probability of the following two events: 
the sum is 7 or the sum is 11. First, we need some tools for finding the probability of a 
combination of events.

The probability is high that, on this roll at least, your roommate will not land on 
Boardwalk. 

For event A in Example 14, note that

PsAd 1 PsACd 5
1

12
1

11

12
5 1

Is this a coincidence, or does the sum of the probabilities of an event and its comple-
ment always add to 1? Recall the Law of Total Probability (Section 5.1), which states 
that the sum of all the outcome probabilities in the sample space must be equal to 1. 
Because any event A and its complement AC together make up the entire sample space, 
then it always happens that P(A) + P(AC) = 1.
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2615.2 Combining Events

Table 6  Contingency table of gender and survival status of passengers and crew of RMS 
Titanic. The intersection of Female and Survived is highlighted.

Female Male Total

Did not survive 126 1364 1490

Survived  367  711

Total 470 1731 2201

union and intersection of events
The union of two events A and B is the event representing all the outcomes that belong to 
A or B or both. The union of A and B is denoted as A ∪ B and is associated with “or.” In 
other words, (A ∪ B) 5 (A or B).
 The intersection of two events A and B is the event representing all the outcomes that 
belong to both A and B. The intersection of A and B is denoted as A ∩ B and is 
associated with “and.” In other words, (A ∩ B) 5 (A and B).

If you are asked to find the probability of “A or B,” you should find the probability 
of A ∪ B. Figure 13 shows the union of two events, with the red dots indicating the 
outcomes. Note from Figure 13 that the union of the events A and B refers to all out-
comes in A or B or both. Figure 14 shows that the intersection of the two events is  
the part where A and B overlap. Both union and intersection are commutative. That is, 
(A ∪ B) = (B ∪ A) and (A ∩ B) = (B ∩ A). In other words, (A or B) = (B or A) and 
(A and B) = (B and A).

Recall from Section 2.1 that a contingency table (also known as a crosstabulation) is a 
tabular summary of the relationship between two categorical variables. Table 6 con-
tains a contingency table summarizing the gender and survival status of the passengers 
and crew of RMS Titanic. 

Event A Event B

Sample space

FiGure 13 Union of events A 
and B, (A ø B) 5 (A or B).

Event A Event B

Sample space

A ∩ B

FiGure 14 Intersection of events  
A and B, (A > B) 5 (A and B).

examPle 15 union and intersection

Suppose our experiment is to select one person at random from the passengers and 
crew. Define the following events:

F: Person is a female

S: Person survived

a. Find the intersection of these events, (F and S).

b. Find the union of these events, (F or S).

Source: Report on the Loss of the “Titanic” (S.S.). British Board of Trade Inquiry Report (reprint), Allan Sutton 
Publishing, Gloucester, United Kingdom, 1990.

344

Intersection of Female and Survived
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262 Chapter 5 Probability

Solution
a. The intersection of F and S is the event containing the outcomes that are common 

to both F and S. Note in Table 6 that the female outcomes form a column and the 
survived outcomes form a row. The intersection of F and S lies at the “intersection” 
of this column and this row, as illustrated in Table 6. The green cell belongs both  
to the Female column and the Survived row, and thus belongs to both events. The 
green cell therefore represents the intersection, (F and S), which includes the  
344 passengers and crew who were both female and survived.

b. The union of F and S is the event containing all the people who were either 
female or who survived, or both. That is, the union (F or S) contains the 
following groups:

● F: Those who were female (126 who did not survive and 344 who did survive)

● S: Those who survived (344 females and 367 males).

Thus, in Table 6, the union (F or S) is represented by the cells containing 126, 344, 
and 367.

Addition rule
We are often interested in finding the probability that either one event or another event may 
occur. The formula for finding these kinds of probabilities is called the addition rule.

2

NOW YOU CAN DO
Exercises 13–18.

YOUR TURN
 #9

Refer to the experiment in Example 15. Define the following events: 

M: Person is a male

N: Person did not survive

a. Find (M and N).

b. Find (M or N).

(The solutions are shown in Appendix A.)

Addition rule
P ( A ∪ B ) = P ( A ) + P ( B ) – P ( A ∩ B )

In other words,
P ( A or B ) = P ( A ) + P ( B ) – P ( A and B )

We can use Figure 15 to understand the Addition Rule. We are trying to find  
P(A or B), the probability of all the outcomes in A or B or both. The first part of the 
formula says to add the probabilities of the outcomes in A to those of the outcomes in 
B. But what about the overlap between A and B, which includes outcomes that belong 
to both events? To avoid counting the outcomes in the overlap (intersection) twice, 
we have to subtract the probability of the intersection, P(A and B). 

FiGure 15 How the Addition Rule works.

P (A)

+

+

–

–P (B) P (A and B )

What Does the 
Addition Rule Mean?
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Continuing with the RMS Titanic data from Example 15, Table 6 is reproduced here. 
Find the probability that a randomly chosen passenger or crew member had the follow-
ing characteristics:

a. Was female

b. Survived

c. Was female and survived

d. Was female or survived

examPle 16 Addition rule

Table 6  Contingency table of gender and survival status of passengers and crew of 
RMS Titanic. The intersection of Female and Survived is highlighted.

Female Male Total

Did not survive 126 1364 1490

Survived  367  711

Total 470 1731 2201

Solution
a. Here, we seek P(F). There were 470 female passengers and crew among the 

2201 people on board the Titanic. Therefore, P(F) = 470/2201 = 0.2135.

b. We are looking for P(S). Of the 2201 people on board the Titanic, 711 survived. 
Thus, P(S) = 711/2201 5 0.3230.

c. Those who were female and survived represent the intersection (F and S). In 
Example 15, we found that these were represented by the green cell with 344 
people in it, lying in the intersection of the Female column and the Survived row. 
Therefore, P(F and S) = 344/2201 = 0.1563.

d. Here, we seek P(F or S). By the Addition Rule,

P(F or S) = P(F ) + P(S) – P(F and S) = 0.2135 + 0.3230 – 0.1563 = 0.3802

YOUR TURN
 #10

Refer to the experiment in Example 15. Define the following events: 

M: Person was a male

N: Person did not survive

Find the probability that a randomly chosen passenger or crew member has the follow-
ing characteristics: 

a. Was male

b. Did not survive

c. Was a male who did not survive

d. Was a male or did not survive

(The solutions are shown in Appendix A.)

NOW YOU CAN DO
Exercises 19–44.

Two events are said to be mutually exclusive, or disjoint, if they have no outcomes in 
common.

344

Mutually Exclusive Events
When drawing a card at random from a deck of 52 cards, the events “a heart is drawn” 
and “a diamond is drawn” have no outcomes in common. That is, no card is both a 
heart and a diamond. We say that these two events are mutually exclusive. 

Intersection of Female and Survived
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264 Chapter 5 Probability

Note that any event and its complement are always mutually exclusive. Other 
examples of mutually exclusive events are given in Table 7.

Table 7 Examples of mutually exclusive events

Experiment Mutually exclusive events

Draw a single card from a deck of 52 cards Card is red; card is a spade.

Buy a stock Stock will increase in value; stock will not 
change in value.

Select a student at random Student is 30 years old or older; student is 
under 18 years old.

Select a college course at random Course has 3 credits; course has 4 credits.

Figure 16 shows how mutually exclusive events are represented graphically. It 
shows the events

A = {1, 3, 5, 7, 9}  and  B = {0, 2, 4, 6, 8}

with sample space S = {0, 1, 2, 3, 4, 5, 6, 7, 8, 9}.

Note that no overlap exists between the two events. When two events are mutually 
exclusive, they share no outcomes, and therefore the intersection of mutually exclusive 
events is empty. Because the intersection (A and B) is empty, then for mutually exclu-
sive events, P(A and B) = 0. Therefore, we can formulate a special case of the addition 
rule for Mutually exclusive events A and B:

P(A or B) = P(A) + P(B) – P(A and B) = P(A) + P(B) – 0 = P(A) + P(B)

Event A

1

5
9

3

2

8

4

0

6
7

Event B

Sample space

FiGure 16 Even and odd digits are mutually exclusive. Note that the overlap (A and B) is 
empty, so that P (A and B) = 0.

Addition rule for Mutually exclusive events
If A and B are mutually exclusive events, P (A or B) = P (A) + P (B).

examPle 17 Addition rule for mutually exclusive events
The National Center for Education Statistics conducted a survey regarding the living 
arrangements of 19,735 college students. The results are shown in Table 8. 

Table 8 Contingency table of college student living arrangements

On campus Off campus With parents Total

Females 1,368 5,741 4,103 11,212

Males 1,240 4,170 3,113 8,523

Total 2,608 9,911 7,216 19,735
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2655.2 Combining Events

Calculate the following probabilities for a randomly chosen college student:
a. Lives on campus, P(C).

b. Lives with parents, P(W).

c. Lives on campus or with parents, P(C or W).

Solution
a. A total of 2,608 of the 19,735 students live on campus, so P(C) = 2,608/19,735 = 

0.1322.

b. Of the 19,735 students, 7,216 live with parents, so P(W) = 7,216/19,735 = 0.3656.

c. Living on campus and living with parents are mutually exclusive. So, by the 
Addition Rule for Mutually Exclusive Events, P(C or W) = P(C) + P(W) = 
0.1322 + 0.3656 = 0.4978.

Refer to Example 17. Find the probability that a randomly chosen student lives on 
campus or lives off campus. 

(The solution is shown in Appendix A.)

NOW YOU CAN DO
Exercises 45−48.

YOUR TURN
 #11

Section 5.2 Summary
 1. We may combine events using the concepts of 
complement, union, and intersection.
 2. The Addition Rule provides the probability of event A 
or event B to be the sum of their two probabilities minus 

the probability of their intersection. Mutually exclusive 
events have no outcomes in common.

Section 5.2 Exercises
ClarifyinG the ConCepts

 1. Describe in your own words what it means for two 
events to be mutually exclusive. (p. 263)
 2. Describe the intersection of two mutually exclusive events. 
(p. 264)
 3. Describe the union of two mutually exclusive events.  
(p. 264)
 4. Is it true that the union of two events always contains at 
least as many outcomes as the intersection of two events? Use 
Figures 13 and 14 to help you visualize this problem. (p. 261)
 5. If we choose a student at random from your college or 
university, is it more likely that we choose a male or a male 
football player? Why? (p. 261)
 6. What is your personal estimate of the probability that it 
will rain on any given day? How about the probability that it 
won’t rain? Why do these numbers have to add up to 1 (or 
100%)? (p. 260)

praCtiCinG the teChniques

CheCK it out!

to do Check out topic

Exercises 7–12 Example 14 Finding the probability of 
the complement of an event

Exercises 13–18 Example 15 Union and intersection
Exercises 19–44 Example 16 Addition Rule
Exercises 45–48 Example 17 Addition Rule for 

mutually exclusive events

•

For Exercises 7–12, consider the experiment of rolling a fair 
die once. Find the indicated probabilities:
 7. Observing a number that is not 6
 8. Observing some other number than 1
 9. The complement of the event E, where E: {1, 3, 5}
10. LC, where L: {5, 6}
11. EC, where E: {1, 3, 5}
12. Not rolling an even number

For Exercises 13–18, consider the experiment of drawing a 
single card at random from a deck of cards. Define the 
following events. Find the indicated unions and 
intersections:

J: The card is a jack.
B: The card is a black suit.
S: The card is a spade.

13. J ∩ B
14. J ∩ S
15. B ∩ S
16. J ∪ B
17. J ∪ S
18. B ∪ S

For Exercises 19–24, consider the experiment of drawing a 
single card at random from a deck of cards. Define the 
following events. Find the indicated probabilities:

J: The card is a jack.
B: The card is a black suit.
S: The card is a spade.

Larose_3e_ch05.indd   265 16/06/15   5:13 PM



© 20
16

 W
.H. F

ree
man

 Co.

266 Chapter 5 Probability

19. P(J ∩ B)
20. P(J ∩ S)
21. P(B ∩ S)
22. P(J ∪ B)
23. P(J ∪ S)
24. P(B ∪ S)

For Exercises 25–36, refer to Table 9, a contingency table 
containing the counts of those who did and did not 
survive the sinking of the RMS Titanic, along with 
whether they were adults or children. Find the following 
probabilities:

taBle 9 Contingency table of age and survival status

Child adult total

Did not survive  52 1438 1490
survived  57  654  711
total 109 2092 2201

25. P(Child or Adult)
26. P(Child and Adult)
27. P(Child and Survived)
28. P(Child or Survived)
29. P(Child and Did not survive)
30. P(Child or Did not survive)
31. P(Survived and Did not survive)
32. P(Adult and Survived)
33. P(Adult or Survived)
34. P(Adult and Did not survive)
35. P(Adult or Did not survive)
36. Were your chances of surviving better as an adult or as  
a child?

Forbes magazine’s Global 2000 is a list of the 2000 largest 
companies on the globe. Table 10 lists the top 10 largest 
companies, showing the country and whether the company’s 
assets surpass $1 trillion. Table 11 contains the contingency 
table of this data.

taBle 10 top 10 companies in the Forbes Global 2000

Company Country assets

Industrial and Commercial 
Bank of China

China Over $1 trillion

China Construction Bank China Over $1 trillion

Agricultural Bank of China China Over $1 trillion

JPMorgan Chase USA Over $1 trillion

Berkshire Hathaway USA Under $1 trillion

Exxon Mobil USA Under $1 trillion

General Electric USA Under $1 trillion

Wells Fargo USA Over $1 trillion

Bank of China China Over $1 trillion

PetroChina China Under $1 trillion

Source: www.forbes.com/global2000.

taBle 11 Contingency table of country and assets

assets

over  
$1 trillion

under  
$1 trillion total

Country

China 4 1  5

usa 2 3  5

total 6 4 10

For Exercises 37–44, the experiment is to select a company 
at random. Use the completed Table 10 to find the probability 
of the following:
37. Choosing a company from China
38. Choosing a company from the USA
39. Choosing a company with over $1 trillion in assets
40. Choosing a company with under $1 trillion in assets
41. Selecting a company that is from China and has over  
$1 trillion in assets
42. Selecting a company that is from the USA and has over 
$1 trillion in assets
43. Selecting a company that is from the USA or has over 
$1 trillion in assets
44. Selecting a company that is from the USA or has under 
$1 trillion in assets

The following table contains a list of actors who have received 
many Oscar nominations but have never won an Oscar.

actor nominations actor nominations
Peter O’Toole 8 Tom Cruise 3
Richard 
Burton

7 Will Smith 2

Glenn Close 6 John 
Travolta

2

Leonardo 
DiCaprio

5 Edward 
Norton

2

Sigourney 
Weaver

3 Judy 
Garland

2

Johnny Depp 3 James 
Dean

2

Suppose we select one actor at random. For Exercises 45–48, 
find the probability that the randomly selected actor  
received the following numbers of nominations without 
winning an Oscar:
45. 2 or 3 nominations
46. 2 or 4 nominations
47. 3 or 4 nominations
48. 7 or 8 nominations

applyinG the ConCepts

technology adopters. Use the following information for 
Exercises 49–51. The Gallup organization published a study8 

nooscars
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in which it categorized American technology adopters as 
either Super Tech Adopters (31%), Smart Phone Reliants 
(19%), Mature Technophiles (22%), or Tech-Averse Olders 
(28%). Suppose we select one technology adopter at random.
49. Find the following probabilities:

a. Selecting a Super Tech Adopter or a Smart Phone 
Reliant

b. Selecting a Super Tech Adopter or a Mature 
Technophile

50. Find the following probabilities:
a. Selecting a technology adopter who is not a Super 

Tech Adopter
b. Selecting a technology adopter who is neither a 

Super Tech Adopter nor a Tech-Averse Older
51. Find the following probabilities:

a. Selecting a technology adopter who is a Super Tech 
Adopter or a Smart Phone Reliant or a Mature 
Technophile. 

b. Selecting a technology adopter who is neither a 
Super Tech Adopter nor a Smart Phone Reliant nor a 
Mature Technophile.

52. facebook females and Males. The Facebook  
Social Ads Platform reported the following number of  
users in the United States in 2014, by gender: females:  
96 million, males: 82 million, unknown: 2 million. If we 
choose a Facebook user at random, find the following 
probabilities:

a. We choose a female or unknown.
b. We choose a female or someone who is not a female.
c. We select a female or a male.

53. Game of Craps. You win the casino game of craps if 
you roll a 7 or 11. Find the probability of rolling a sum of 7 
or 11 when two fair dice are rolled.

Card Game. Use the following experiment for Exercises 
54–57: you choose one card at random from a deck of  
52 cards, and you will win $3 if the card is either an ace  
or a heart. 
54. Find the probability of winning this game.
55. What is a fair price to pay to play this game? 
56. Suppose you win by drawing either a king or a red card.
What is the probability of winning the game now?
57. What is a fair price to pay to play the game in  
Exercise 56?
58. social networking apps. The Nielsen Apps Playbook 
was a survey taken in 2010 of 3691 males and females  
on the use of social networking apps9 (mobile software 
applications). The results are shown in the following  
table:

Find the probability that a randomly chosen person has the 
following characteristics:

a. Is female
b. Has downloaded a social networking app in the last 

30 days
c. Is a female who has downloaded a social networking 

app in the last 30 days
d. Is a female or has downloaded a social networking 

app in the last 30 days
e. Is not a female
f. Has not downloaded a social networking app in the 

last 30 days
59. A study of online dating behavior found that users of a 
particular online dating service self-reported their physical 
appearance according to the counts given in Table 12.10

taBle 12 Gender and self-reported physical appearance

physical appearance

Gender
Very 

attractive attractive average

prefer 
not to 

answer total

female 3,113 16,181  6,093 3,478 28,865

Male 1,415 12,454  7,274 2,809 23,952

total 4,528 28,635 13,367 6,287 52,817

Using this information, find the probability that a randomly 
chosen online dater has the following characteristics:

a. Is female
b. Self-reported as attractive
c. Is a female who self-reported as attractive
d. Is a female or self-reported as attractive
e. Self-reported as attractive or self-reported as average

recommended Gasoline for Different Car sizes. Consider 
Table 13, showing the size and recommended gasoline for 
ten 2014 automobiles. 

taBle 13 size and recommended gasoline for ten 
2014 automobiles

Car Car size
recommended 
gasoline

BMW 328i Compact Premium

Chevrolet Camaro Compact Regular

Honda Accord Compact Regular

Cadillac CTS Midsize Premium

Nissan Sentra Midsize Regular

Subaru Legacy AWD Midsize Premium

Toyota Camry Midsize Regular

Ford Taurus Large Regular

Hyundai Genesis Large Premium

Rolls-Royce Large Premium
Source: www.fueleconomy.gov.

has downloaded a social networking  
app in the last 30 days

yes no

Male  884 841

female 1220 746
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60. Use Table 13 to complete the contingency table shown 
in Table 14.

recommended gasoline

regular premium total

Car size

Compact

Midsize

large

total

For Exercises 61–64, the experiment is to select a car at 
random. 
61. Use the completed Table 14 to find the probability of the 
following:

a. Choosing a compact car
b. Choosing a car that is not a compact car
c. Selecting a midsize car
d. Selecting a car that is not a midsize car

62. Use the completed Table 14 to find the probability of the 
following:

a. Choosing a car that uses regular gasoline
b. Choosing a car that does not use regular gasoline
c. Selecting a compact car that uses premium  

gasoline
d. Selecting a compact car that uses regular  

gasoline
63. Use the completed Table 14 to find the following 
probabilities:

a. Choosing a midsize car that uses premium  
gasoline

b. Choosing a midsize car that uses regular  
gasoline

c. Selecting a large car that uses premium  
gasoline

d. Selecting a large car that uses regular gasoline
64. Use the completed Table 14 to find the following 
probabilities:

a. Choosing a compact car or a car that uses premium 
gasoline

b. Choosing a compact car or a car that uses regular 
gasoline

c. Selecting a car that uses regular gasoline and is not a 
compact car

d. Selecting a car that uses regular gasoline or is not a 
compact car

e. Selecting a car that uses premium gasoline or a large 
car

top 10 Movies of all time. Table 15 contains the top 10 
domestic movies of all time, according to Box Office Mojo 
(http://boxofficemojo.com), along with the studio, whether 
the movie grossed over or under $500 million, and the 
century in which the movie was produced.

taBle 15 top 10 domestic movies of all time

rank Movie studio

Gross 
over or 
under 
$500 
million

Century 
produced

 1 Avatar Fox Over 21st

 2 Titanic Other Over 20th

 3 Marvel’s The 
Avengers

Other Over 21st

 4 The Dark 
Knight

Warner Over 21st

 5 Star Wars: 
Episode I - The 
Phantom Menace

Fox Under 20th

 6 Star Wars Fox Under 20th

 7 The Dark 
Knight Rises

Warner Under 21st

 8 Shrek 2 Other Under 21st

 9 E.T.: The 
Extra-Terrestrial

Other Under 20th

10 The Hunger 
Games: 
Catching Fire

Other Under 21st

For Exercises 65–69, find the following probabilities 
regarding the studio and what the movie grossed:
65. Studio was Fox and the movie grossed over $500 million.
66. Studio was not Fox and the movie grossed over  
$500 million.
67. Studio was Fox or the movie grossed over $500 million.
68. Studio was not Fox or the movie grossed over  
$500 million.
69. Studio was Warner and the movie grossed over  
$500 million.

For Exercises 70–73, find the following probabilities about 
the studio and the century produced:
70. Studio was Warner and the movie was produced in the 
20th century.
71. Studio was Warner and the movie was produced in the 
21st century. 
72. Studio was not Warner and the movie was produced in 
the 20th century.
73. Studio was not Warner and the movie was produced in 
the 21st century.

Wheel of fortune! Use Table 16 for Exercises 74–81. 
Imagine yourself on the television game show Wheel of 
Fortune, where contestants guess the letters contained in  
a hidden phrase. You want to ask for the letters that have 
the greatest chance of occurring, so you want to know the 
various probabilities of the letters in the English alphabet.

The experiment is to choose one letter at random from a 
sample of 1000 letters. The sample space is the 26 letters 

taBle 14 Contingency table of car size and 
recommended gasoline
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of the alphabet. The total sample size is 1000, so you can 
find the relative frequencies of the letters in English simply 
by dividing each frequency by the total sample size 
(remember this from Chapter 2?).

taBle 16 frequency distribution of english letters

A B C D E F G

73 9 30 44 130 28 16

H I J K L M N

35 74 2 3 35 25 78

O P Q R S T U

74 27 3 77 63 93 27

V W X Y Z   

13 16 5 19 1

74. Construct a probability model of the frequency 
distribution in Table 16.
75. Find the probability of selecting an E.
76. Find the probability of selecting a vowel, that is, either A, 
E, I, O, or U.
77. Note that selecting a consonant may be considered the 
complement of selecting a vowel. Find the probability of 
selecting a consonant.
78. Choosing one letter at random, which is it more likely to 
be, a consonant or a vowel?
79. Of the eight letters with the highest frequencies, how 
many are vowels?
80. Compare your answers to Exercises 76 and 77, and 
explain why Wheel of Fortune contestants are not allowed to 
guess vowels (they have to buy them).
81. If you were a contestant on Wheel of Fortune and had no 
money to buy a vowel, what would be your first five letter 
choices?

Gender and Gpa. The National Center for Education 
Statistics reported the contingency table results in Table 17 
for the gender and the grade point average of the 21,504 
undergraduate students it surveyed. The experiment is to 
select one random selected student. Use Table 17 to calculate 
the probabilities indicated in Exercises 82–93.

taBle 17 Contingency table of gender and Gpa

Gpa < 2.5
Gpa 2.5 

to < 3
Gpa 3 
to < 3.5

Gpa 
3.5 or 
higher total

females 2,698 2,439 3,314 3,868 12,319

Males 2,535 1,975 2,324 2,351 9,185

total 5,233 4,414 5,638 6,219 21,504

82. Student is female.
83. Student is male.
84. Student has GPA < 2.5.
85. Student is female and has a GPA < 2.5.
86. Student is male and has a GPA < 2.5.
87. Student is female or has a GPA < 2.5.

88. Student is male or has GPA < 2.5.
89. Student does not have a GPA < 2.5.
90. Student is female and does not have a GPA < 2.5.
91. Student is male and does not have a GPA < 2.5.
92. Student is female or does not have a GPA < 2.5.
93. Student is male or does not have a GPA < 2.5.

BrinGinG it all toGether

Best-selling Video Games. Table 18 contains the top 20 
best-selling video games in the United States for the week of 
May 17, 2014, along with the game platform, publishing 
studio, and the type of game. Use this information for 
Exercises 94–102.

taBle 18 top 20 best-selling video games in the 
united states for the week of May 17, 2014

Game/platform studio type

Minecraft for PS3 Sony Adventure

Minecraft for Xbox 360 MS Adventure

Kirby: Triple Deluxe for 3DS Nintendo Platform

MLB 14 The Show for PS4 Sony Sports

Titanfall for Xbox One Electronic 
Arts

Shooter

Call of Duty: Ghosts for 
Xbox 360

Activision Shooter

Bound by Flame for PS4 Focus Action

Pokemon X/Y for 3DS Nintendo Role-Playing

Titanfall for Xbox 360 Electronic 
Arts

Shooter

Grand Theft Auto V for  
Xbox 360

Take-Two Action

Grand Theft Auto V for PS3 Take-Two Action

Call of Duty: Ghosts for PS4 Activision Shooter

Super Luigi U for WiiU Nintendo Platform

Super Mario Brothers U for 
WiiU

Nintendo Action

Call of Duty: Ghosts for PS3 Activision Shooter

Borderlands 2 for PSV Take-Two Shooter

Battlefield 4 for Xbox 360 Electronic 
Arts

Shooter

Forza Motorsport 5 for  
Xbox One

MS Racing

Call of Duty: Ghosts for 
Xbox One

Activision Shooter

inFamous: Second Son for PS4 Sony Action

94. Suppose our experiment is to select one video game at 
random from Table 18, and observe its studio. List the video 
games belonging to the following events:

a. S: Sony
b. N: Nintendo. 

95. For each studio in Exercise 94, find the probability of a 
video game being made by that studio.
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 96. Describe in words the complement of the following 
events (save space by not listing them all):

a. S: Sony
b. N: Nintendo. 

 97. For each complement in Exercise 96, find its probability.
 98. What is the sum of the following two probabilities: (i) 
Video game made by Sony, (ii) Video game made by some 
other studio.
 99. Next, suppose our experiment is to select a video 
game at random. Define the following events: S: Studio is 
Sony, N: Studio is Nintendo, A: Type = Action, P: Type = 
Platform. List the video games in the following events: 

a. (S and A)
b. (S or A)
c. (N and P)
d. (N or P)
e. (N and A)
f. (N or A)

100. Find the following probabilities:
a. P (S and A)
b. P (S or A)
c. P (N and P)
d. P (N or P)
e. P (N and A)
f. P (N or A)

101. List the video games in the following events: 
a. (S and N)
b. (S or N)
c. (A and P)
d. (A or P)

102. Find the following probabilities:
a. P (S and N)
b. P (S or N)
c. P (A and P)
d. P (A or P)

WorKinG With larGe Data sets

case  
sTudy

Chapter 5 Case study: the Gardasil Vaccine. 
Open the data set Gardasil. We will explore 
some probabilities about the patient completion 
of the vaccination treatment and whether the 

patient received medical assistance, using the tools and 
techniques we have learned in this section. Use technology 
to complete Exercises 103−107. gardasil

103. Construct a relative frequency distribution of the 
variables medical assistance and completed. Use these to 
find the probability that a randomly selected patient:

a. had medical assistance.
b. completed the vaccine treatment.

104. Construct a contingency table (crosstabulation) of 
medical assistance with completed. Include the row totals, 
column totals, and grand total. 
105. Use the contingency table from Exercise 104 to find 
the probability that a randomly chosen patient:

a. had medical assistance and completed the 
treatment.

b. had medical assistance and did not complete the 
treatment.

c. did not have medical assistance and did complete 
the treatment.

d. did not have medical assistance and did not 
complete the treatment.

106. Think about the four probabilities you found in  
Exercise 105. Do you think that patients who had medical 
assistance were more likely to complete the treatment? 
Provide support for your statement.
107. Find the probability that a randomly chosen patient:

a. had medical assistance or completed the treatment.
b. had medical assistance or did not have medical 

assistance.

5.3 Conditional Probability

OBjecTiveS By the end of this section, I will be able to . . .
1 Calculate conditional probabilities.
2 Explain independent and dependent events.
3 Solve problems using the Multiplication Rule and recognize the difference 

between sampling with replacement and sampling without replacement.
4 Approximate probabilities for dependent events.
5 Apply Bayes’ Rule to solve probability problems.

introduction to conditional Probability
As we progress through this book, you will notice a recurring theme: the more informa-
tion available, the better. Very often, when we are investigating the probability of a 
certain event A, we learn that another event B has occurred. If events A and B are related, 
then the occurrence of event B often influences the probability that event A will occur.

1

270 Chapter 5 Probability
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Table 19 contains the Academy Award winners for Best Actress and Best Actor for 
2009–2014, along with their ages at the time of the award.

examPle 18 having more information often affects the probability of an event

Table 20 is a contingency table, summarizing the information in Table 19, providing 
the counts of the performers’ genders and whether the performer was under age 40.

Table 19 Oscar-winning actresses and actors, and their ages

Year Best actress Film Age Best actor Film Age
2009 Kate Winslet The Reader 33 Sean Penn Milk 48

2010 Sandra Bullock The Blind 
Side

45 Jeff Bridges Crazy Heart 60

2011 Natalie Portman Black Swan 29 Colin Firth The King’s 
Speech

50

2012 Meryl Streep Iron Lady 62 Jean Dujardin The Artist 39

2013 Jennifer Lawrence Silver Linings 
Playbook

22 Daniel Day- 
Lewis

Lincoln 55

Source: www.oscars.org.

Table 20 Contingency table of Oscar-winning performers

Female Male Total

Under age 40 3 1 4

Age 40 or older 2 4 6

Total 5 5 10

Now, if we choose a performer at random from Table 20, the probability of choosing a 
female is P(F)  =   5

10   =  0.5. But what if we were given the extra information that the 
performer is age 40 or older? How does this extra information affect the probability of 
selecting a female?

Solution
Notice that when we are given that the person is age 40 or older, we may restrict 
our attention to the performers who are age 40 or older in Table 20 (highlighted). In 
other words, this extra information reduces the number of possible outcomes in the 
sample space from the 10 performers to the 6 performers who are age 40 or older. 
Of these six performers, two of them are female. Thus, the probability of selecting 
a female, given that the performer is age 40 or older, is 2/6 = 1/3 ≈ 0.33. The extra 
information we were given changed the probability of selecting a female, from 1/2 
to 1/3.

The extra information about a related event changed the probability of the event of 
interest. This type of probability is an example of what is called conditional 
probability.

Note: The vertical line | is read as 
the word “given.” Whatever follows 
the word “given” is assumed to 
have occurred already.

For two related events A and B, the probability of B given A is called a conditional 
probability and is denoted as P (B u A), or P (B given A).
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calculating conditional Probability
The conditional probability that B will occur, given that event A has already taken place, 
equals

P sB given Ad 5 P sB u Ad 5
P sA and Bd

P sAd
5

N sA and Bd
N sAd

Thus, if we let F represent the event that a female is selected and A represent the event 
that the performer is age 40 or older, then

PsFd 5
5

10
5

1

2
      but    PsF given Ad 5 PsF u Ad 5

2

6
5

1

3

Figure 17 can help us visualize how conditional probability works. The idea is that, 
once event A has occurred, the only chance for event F to occur is in the overlap—the 
intersection (F and A). Therefore, the conditional probability that F will occur, given 
that event A has already taken place, is found by taking the ratio PsF and AdyPsAd.

The difference between P (F given A) and P (F and A)
Students sometimes confuse the meanings of P(F given A) with P(F and A). The two 
are very different.
● For P(F and A), neither A nor F has occurred. We don’t know if either will or 

will not occur. Instead, we need to determine the probability that events F and 
A both occurred. Look at Figure 17a. For finding P(F and A), we don’t know 
if our randomly chosen performer is female or is age 40 or older. Two of our 
10 performers are both female and age 40 or older: Sandra Bullock and Meryl 
Streep. Thus, P(F and A) = 2/10 = 1/5.

● For P(F given A) = P(F u A), we assume that the event A has already occurred 
and now need to find the probability of event F, given event A. There is no 
probability involved with the event A, because it has already occurred. Look 
at Figure 17b. For P(F given A) = P(F u A), we are given that the performer is 
age 40 or older; we know this event occurred. Therefore, we can restrict our 
attention solely to performers age 40 or older (event A). Of the six performers 
age 40 or older, two are female. Thus, P(F given A) = P(F u A) = 2/6 = 1/3.

In general, the formula for computing conditional probability is given as follows.

FiGure 17 How conditional probability works.

F = Female A = Age 40 or older(a) (b)

Kate
Winslet

Sandra
Bullock

Sean Penn

Jeff
Bridges

Colin Firth

Daniel Day-
Lewis

Meryl
Streep

Natalie
Portman

Jennifer
Lawrence

 Given A has occurred, F |A looks like: F and A 

A = Age 40 or older

Sandra
Bullock

Sean Penn

Jeff
Bridges

Colin Firth

Daniel Day-
Lewis

Meryl
Streep

F
and
A

Developing Your 
Statistical Sense
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Marketing companies are looking to statistical analysis and data mining in an  
effort to increase the customer response to their promotions. Therefore, these mar-
keting companies are looking to hire more statistics-savvy students. Table 21  
is adapted from a study on direct mail marketing. It contains the numbers of custom-
ers who either responded or did not respond to a direct mail marketing campaign, 
along with whether they had a credit card on file with the company. The two  
events are:

R: Responded to direct mail marketing campaign

C: Has a credit card on file

examPle 19 calculating conditional probability
Sc

ie
nc

e 
P

ho
to

 li
br

ar
y/

A
la

m
y

a. Find the probability that a randomly chosen customer responded to the marketing 
campaign.

b. Calculate the probability that a randomly chosen customer both responded to the 
marketing campaign and has a credit card on file.

c. Find the conditional probability that a randomly selected customer responded, 
given that the customer has a credit card on file.

Solution
a. PsRd 5

NsRd
NsSd. There are N(R) = 48 customers who did respond, and there are  

N(S) = 288 customers in this experiment. Thus, 

PsRd 5
NsRd
NsSd

5
48

288
< 0.1667

b. Here, we are looking for P(R and C), which is the intersection between R and 
C. Earlier, we learned that this is represented by the cell at the intersection of 
the “Did respond” row and the “Credit card yes” column. In Table 21, this cell 
contains N(R and C) = 31 such customers. Thus, the probability that a 
randomly chosen customer both responded to the marketing campaign and has 
a credit card on file = P(R and C) = 31/288 = 0.1076.

c. We will use P(R given C) 5 P(R u C) = N(R and C)/N(C) because, in this 
example, it is easier to work directly with the numbers of outcomes instead of the 
probabilities. From (b), N(R and C) = 31. Also, there are N(C ) = 110 customers 
in total who had a credit card on file. Therefore,

PsR given Cd 5 PsR u Cd 5
NsR and Cd

NsCd
5

31

110
< 0.2818

That is, the probability that a randomly chosen customer responded to the direct mail 
marketing campaign, given that the customer had a credit card on file, is 0.2818

NOW YOU CAN DO
Exercises 9–32.

Source: Data Mining and Predictive Analytics, by Daniel Larose and Chantal 
Larose, Wiley Interscience, 2015.

Table 21 Credit card status and marketing response

Credit card on file?

Response No Yes Total

Did not respond 161  79 240

Did respond  17  31  48

Total 178 110 288
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274 Chapter 5 Probability

Using Table 21, find the probability that a randomly selected customer

a. Did not respond to the marketing campaign.

b. Did not respond to the marketing campaign, given that the customer did not have 
a credit card on file.

(The solutions are shown in Appendix A.)

YOUR TURN
 #12

Conditional Probability
Conditional probabilities can often be interpreted as percentages of some subset of 
a population. For example, the conditional probability that a customer responded, 
given that the customer has a credit card on file, may be interpreted as the percent-
age of customers with credit cards who responded. 

independent events
Having a credit card on file increased the probability of a customer responding from 
0.1667 to 0.2818, so we can say that the probability of responding depends in part on 
whether the customer has a credit card on file. In other words, the events R and C are 
dependent events.

On the other hand, if the probability of responding had been unaffected by whether 
the customer had a credit card on file, then we would have said that R and C were 
independent events. That is, R and C would have been independent events had P(R u C ) 
equaled P(R ). In general, if the occurrence of an event does not affect the probability 
of a second event, then the two events are independent.

2

Events A and B are independent if

P (A given B) = P (A)  or if  P (B given A) = P (B)

Equivalently, using symbols, events A and B are independent if

P (A u B) = P (A)  or if  P (B u A) = P (B)

Otherwise, the events are said to be dependent.
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Strategy for Determining whether Two events Are independent
1. Find P (B).
2. Find P (B given A).
3. Compare the two probabilities. If they are equal, then A and B are independent 

events. Otherwise, A and B are dependent events.

Alternatively, in Step 1 you can find 
P (A) and in Step 2 you can find 
P (A  given  B). Then compare these 
two quantities for Step 3.

What Do These 
Numbers Mean?

Dependent and Independent Events
It may help to think of it this way: Andrew Luck is a superb quarterback for the 
Indianapolis Colts. Let B = the event the Colts win, and let A be the event that 
Andrew Luck gets injured. The Colts are certainly better with their great quarter-
back than without him. So P(B) is greater than P(B u A), because their chances of 
winning decrease if Luck gets injured. Because P(B) ≠ P(B given A), the two events 
A and B are dependent. This makes sense, because the probability of the Colts 
winning is dependent on whether Andrew Luck gets injured. Now, do the same 
calculations—this time letting event C be the event that the water boy for the Colts 
gets injured. It is not likely that the water boy getting injured will affect the Colts’ 
chances of winning, so that P(B) = P(B given C). Thus, the events B = Colts win-
ning and C = water boy gets injured are independent.

Developing Your 
Statistical Sense

Andrew Luck, quarterback for the 
Indianapolis Colts.
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2755.3 Conditional Probability

Table 22 contains a contingency table summarizing the gender and survival status of 
the passengers and crew of RMS Titanic. 

examPle 20 Determining whether two events are independent

examPle 21 Gambler’s Fallacy

Suppose our experiment is to select one person at random from the passengers and 
crew. Define the following events:

F: Person is a female

S: Person survived

Determine whether events F and S are independent.

Solution
We use the strategy for determining whether two events are independent.

Step 1 Find P(F) = P(Person is a female). There are 470 females out of a total of 
2201 passengers and crew. Thus, P(F ) = 470/2201 ≈ 0.21.

Step 2 We need to find P(F given S  ), which is the probability that the person survived, 
given the person was female. We are told that the person was female, so we may 
restrict our attention to the females in the table. In other words, our sample space is 
reduced when we know that the person was a female. Of the 470 females, 344 survived, 
so that P(F given S) = 344/470 ≈ 0.73.

Step 3 Because, PsFd ± PsF given Sd, we conclude that F and S are dependent events.

Source: Report on the Loss of the “Titanic” (S.S.). British Board of Trade Inquiry Report (reprint), Allan Sutton 
Publishing, Gloucester, United Kingdom, 1990.

YOUR TURN
 #13

In Example 20, determine whether being a male and not surviving are independent. 

(The solution is shown in Appendix A.)

NOW YOU CAN DO
Exercise 33−52.

Don’t Confuse Independent Events and Mutually Exclusive Events
It is important to stress the difference between independent events and mutually 
exclusive events. Mutually exclusive events have no outcomes in common. For two 
events to be independent means that the occurrence of one does not affect the prob-
ability of the other. The concepts are different. 

Suppose we have tossed a fair coin 10 times and have observed heads come up every 
time. Find the probability of tails on the next toss.

Solution
We have observed an unusual number of heads, so we might think that the probability 
of tails on the next toss is increased. However, the short answer is “Not so.” Successive 
tosses of a fair coin are independent because the coin has no memory of its previous 

Developing Your 
Statistical Sense

Table 22  Contingency table of gender and survival status of passengers and crew of 
RMS Titanic. Notice that when we are given that the person is a female, we 
may restrict our attention to the females in the table.

Female Male Total

Did not survive 126 1364 1490

Survived 344 367 711

Total 470 1731 2201
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276 Chapter 5 Probability

NOW YOU CAN DO
Exercises 53−58.

tosses. Thus, what happened on the first 10 tosses has no effect on the next toss. Prob-
ability theory tells us that, in the long run, the proportion of heads and tails will eventu-
ally even out if the coin is fair. Therefore, the probability of tails on the next toss is 0.5. 
This is an example of the Gambler’s Fallacy.

Multiplication rule
Just as the Addition Rule is used to find probabilities of unions of events, the Multipli-
cation rule is used to find probabilities of intersections of events. Recall the formula 
for the conditional probability of event B given event A:

PsB given Ad 5
PsA and Bd

PsAd
  where PsAd ± 0

We solve for P(A and B) by multiplying each side by P(A):

P(A and B) = P(A) · P(B given A)

Similarly, consider the conditional probability of event A given event B:

PsA given Bd 5
PsA and Bd

PsBd
  where PsBd ± 0

Solving for P(A and B) gives us a second equation for P(A and B):

P(A and B) = P(B) · P(A given B)

The two equations for P(A and B) lead directly to the Multiplication Rule.

3

Multiplication rule

P (A and B) = P (A) · P (B given A)   or equivalently   P (A and B) = P (B) · P (A given B)

According to the Pew Internet and American Life Project,11 35% of American adults 
have cell phones with apps, but only 68% of those who have apps on their cell phones 
actually use the apps. Define the following events:

A:  American adult has a cell phone with apps.

U: American adult uses the apps on his or her cell phone.

a. Find P(A).

b. Find P(U  given A), the probability that an American adult uses the apps, given 
that he or she has a cell phone with apps.

c. Use the multiplication rule to calculate P(A and U ), the probability that an American 
adult has a cell phone with apps and uses the apps on his or her cell phone.

examPle 22 Multiplication rule

Solution
a. According to the study, 35% of American adults have a cell phone with apps. So 

P(A) = 0.35.

b. The research says that 68% of those who have apps actually use them, so  
P(U  given  A) = 0.68.

c. Using the Multiplication Rule, we have

P(A and U) = P(A) · P(U given A) = 0.35(0.68) = 0.238

The probability that an American adult has a cell phone with apps and uses them is 0.238. 
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2775.3 Conditional Probability

YOUR TURN
 #14

Suppose our experiment is to toss a fair die twice. Find the probability of rolling two 
sixes in a row.

(The solution is shown in Appendix A.)

By the definition of independent events (page 274), when events A and B are indepen-
dent, P(A given B) = P(A) or P(B given A) = P(B). Using these identities, we can for-
mulate a special case of the Multiplication Rule. Using P(A given B) = P(A), we can 
write the Multiplication Rule as

P(A and B) = P(B) · P(A u B) = P(B) P(A) = P(A) P(B)

Equivalently, the Multiplication Rule also states that P(A and B) = P(A) · P(B given A), 
but if A and B are independent, P(B given A) = P(B), so, again, P(A and B) = P(A) P(B).

Multiplication rule for Two independent events
If A and B are any two independent events, P(A and B) = P(A) P(B).

Successive spins of the roulette wheel are independent because the wheel does not remem-
ber its result from the previous spin. Suppose the experiment is to spin the roulette wheel 
two times and to bet on red each time. There are 18 red numbers out of a total of 38 num-
bers on the wheel. What is the probability that red will occur twice in succession?

Solution
Define the following events:

A: Roulette wheel comes up red on the first spin.

B: Roulette wheel comes up red on the second spin.

We have the probability of each event given as:

P(A) = P(B) = 
18

38
Then, because the successive spins are independent, the Multiplication rule for two 
independent events tells us:

P(Winning) = P(A and B) = P(A) · P(B) = 118

382118

382 < 0.2244

examPle 23 Multiplication rule for two independent events

YOUR TURN
 #15

For the roulette experiment in Example 23, what is the probability of not getting red on 
the first spin and not getting red on the second spin?

(The solution is shown in Appendix A.)

NOW YOU CAN DO
Exercises 59−66.

Sampling With and Without Replacement
The relationship between two events can be determined by the way the samples are 
chosen. Two methods of choosing samples are sampling with replacement and sam-
pling without replacement.

In sampling with replacement, the randomly selected unit is returned to the population 
after being selected. When sampling with replacement, it is possible for the same unit to 
be sampled more than once.
 In sampling without replacement, the randomly selected unit is not returned to the 
population after being selected. When sampling without replacement, it is not possible for 
the same unit to be sampled more than once.

Larose_3e_ch05.indd   277 16/06/15   5:13 PM



© 20
16

 W
.H. F

ree
man

 Co.

278 Chapter 5 Probability

We draw a card at random from a shuffled deck, observe the card, and return it to the 
deck. The deck is then reshuffled, and we draw another card at random. What is the 
probability that both cards we select will be aces?

Solution
Define the following events:

A: Observe an ace on the first draw.

B: Observe an ace on the second draw.

We want to find P(A and B), the probability of observing an ace on the first draw and an 
ace on the second draw. From the Multiplication Rule, P(A and B) = P(A) · P(B u A). To 
find P(A ), recall that there are 4 aces in the deck of 52 cards. It is reasonable to assume 
that all cards are equally likely to be selected, so using the classical method, P(A) = 
4∕52. Similarly, P(B) = 4∕52.

Next, we need to find P(B given A), the probability of observing an ace on the  
second draw, given that we observe an ace on the first draw. Because the deck of  
52 cards has not changed (except for shuffling), there are still 52 cards—4 of which 
are aces. Therefore, P(B given A) = 4∕52. Thus, the probability that both cards we 
select will be aces is P(A and B) = P(A) · P(B given A) = (4∕52)(4∕52) ≈ 0.0059.

Note that P(B given A) = P(B) = 4∕52. Thus, by the alternative method for deter-
mining independence, A and B are independent events when sampling with 
replacement. 

examPle 24 Sampling with replacement

YOUR TURN
 #16

For the experiment in Example 24, what is the probability of observing hearts on the 
first draw and observing hearts on the second draw, if we sample with replacement?

(The solution is shown in Appendix A.)

NOW YOU CAN DO
Exercises 67−70.

We can generalize this result as follows.

When sampling with replacement, successive draws can be considered independent.

Suppose we alter the experiment in Example 24 as follows: We draw a card at random 
from a shuffled deck, hold onto the card (do not replace it) while the deck is reshuffled, 
and then select another card at random. What is the probability that both cards we 
select will be aces?

Solution
Define events A and B as in Example 24. Again we use the Multiplication Rule to find 
P(A and B). The difference in this experiment comes when finding P(B u A), the prob-
ability of observing an ace on the second draw given an ace on the first draw. Once 
we select the first ace, we do not replace it in the deck. Therefore, when the deck is 
reshuffled, it has only 51 cards left, only 3 of which are aces. The classical method then 
gives the probability of observing an ace on the second draw:

PsB given Ad 5
number of aces in the deck

number of cards in the deck
5

3

51

Thus, the probability that both cards we select will be aces is

P(A and B) = P(A) · P(B given A) = 
4

52
?  

3

51
 5

12

2652
< 0.0045

examPle 25 Sampling without replacement
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2795.3 Conditional Probability

This probability is somewhat less than the probability that both cards will be aces when 
sampling with replacement. Note that here we found that P(B given A) was not equal to 
P(B). Thus, by the alternative method for determining independence, A and B are not 
independent events; they are dependent events. 

YOUR TURN
 #17

For the experiment in Example 25, what is the probability of observing hearts on the 
first draw and observing hearts on the second draw, if we sample without replacement? 

(The solution is shown in Appendix A.)

NOW YOU CAN DO
Exercises 71−74.

When sampling without replacement, successive draws should be considered dependent.

Alternative Method for Determining independence
If P(A) · P(B) = P(A and B), then events A and B are independent.
If P(A) · P(B) ≠ P(A and B), then events A and B are dependent.

Note that the Multiplication Rule for Independent Events provides us with an 
alternative method for determining whether two events are indeed independent.

examPle 26  Determining independence using the alternative method

We return to the direct mail marketing data from Example 19, reproduced here in  
Table 23. Use the alternative method for determining independence to determine 
whether the following two events are independent:

 R: Responded to direct mail marketing campaign.

 C: Has a credit card on file.

Table 23 Credit card status and marketing response

Credit card on file?

Response No Yes Total

Did not respond 161  79 240

Did respond  17  31  48

Total 178 110 288

Source: Daniel Larose and Chantal Larose, Data Mining and Predictive Analytics  
(Wiley Interscience, 2015).

Solution
Using Table 23, we may find the following probabilities:

PsRd 5
48

288
        PsCd 5

110

288
        PsR and Cd 5

31

288
< 0.1076

PsRd ? PsCd 5
48

288
?

110

288
< 0.0637

Because 0.0637 ≠ 0.1076, we have P(R) · P(C) ≠ P(R and C); therefore, R and C are 
dependent.

NOW YOU CAN DO
Exercises 79–84.

We can generalize this result as follows.
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280 Chapter 5 Probability

The next example illustrates the relationship between mutually exclusive events and 
independence.

examPle 27  conditional probability for mutually exclusive events

Suppose two events A and B are mutually exclusive, with P(A) > 0 and P(B) > 0.

a. Find P(B given A).

b. Are events A and B independent or dependent?

Solution
a. Because A and B are mutually exclusive, P(A and B) = 0. Then

PsB given Ad 5
PsA and Bd

PsAd
5 0

That is, if event A has occurred, then event B cannot occur. This is a natural conse-
quence of events A and B being mutually exclusive.

Two events are independent if the occurrence of one does not affect the probability 
that the other will occur. However, as we saw in (a), if event A occurs, then the prob-
ability that event B will occur is 0. Thus, we would expect events A and B to be 
dependent.

What Results Might We Expect?

b.  We are given that P(A) > 0 and P(B) > 0. Thus, the product P(A) · P(B) is  
also greater than 0. However, from (a), P(A and B) = 0. Thus, P(A) · P(B) ≠  
P(A and B), and from the alternative method for determining independence,  
we conclude that events A and B are dependent.

NOW YOU CAN DO
Exercises 85–92.

We can extend the Multiplication Rule to cover n independent events.

Multiplication rule for n independent events
If A, B, C, ... are independent events, then P (A and B and C and ...) = P (A) · P (B) · P (C ) …

examPle 28  Multiplication rule for n independent events

According to the National Health Interview Survey, 24% of Americans ages 18–44 
smoke tobacco. In a random sample of n = 3 Americans ages 18–44, find the prob-
ability that all three smoke.

Solution
The U.S. Census Bureau estimates that over 100 million Americans are ages 18–44. We 
will shortly see that, because the sample of 3 is so small compared to the population of 
over 100 million, it is reasonable to assume that the successive draws are independent. 
Let S

i
 denote the event that the ith American in the 18–44 age group smokes.

P(S1) = P(S2) = P(S3) = 0.24

In other words, if two events are 
mutually exclusive, then they are 
dependent.
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2815.3 Conditional Probability

Then, using the Multiplication Rule for n Independent Events,

P(S1 and S2 and S3) = P(S1) · P(S2) · P(S3) = (0.24)(0.24)(0.24) = (0.24)3 = 0.013824

YOUR TURN
 #18

NOW YOU CAN DO
Exercises 93–100.

Refer to Example 28. In a random sample of n = 10 Americans ages 18–44, find the 
probability that all 10 smoke.

(The solution is shown in Appendix A.)

examPle 29  Solving an “at least” problem

Next, we turn to solving an “at least” problem. This involves a technique that uses 
complements in order to give us a nice shortcut for calculating a probability. 

Using information in Example 28, find the probability that, in a random sample of 5 
Americans ages 18–44, at least 1 of them smokes.

Solution
The phrase “at least” means that one or more of the five Americans smoke, so the prob-
ability we are looking for is:

P(1 or 2 or 3 or 4 or 5 Americans smoke)

Now, each of these events is mutually exclusive, meaning that our sample can’t yield 
exactly 1 American who smokes and exactly 2 Americans who smoke. Thus, by the 
Addition Rule for Mutually Exclusive Events, the above probability equals:

P(1 American smokes) + P(2 Americans smoke) + … + P(5 Americans smoke)

Calculating all these probabilities would take a while. So, we can use the probability 
of the complement we learned earlier to get us a shortcut. Note that “at least 1 Ameri-
can smokes” is the complement of “no Americans smoke.” Then, because the comple-
ment rule for probability is: P(AC) = 1 – P(A), we get:

P(At least 1 of the 5 Americans smokes)

= 1 – P(None of the 5 Americans smokes because the events are independent)

= 1 – P(1st doesn’t smoke and 2nd doesn’t smoke and … and 5th doesn’t smoke)

= 1 – P(1st doesn’t smoke) · P(2nd doesn’t smoke) · … · P(5th doesn’t smoke)

= 1  –  (0.76)5 because P(not smoking) = 0.76

= 0.7464

NOW YOU CAN DO
Exercises 101−104.

YOUR TURN
 #19

For the experiment in Example 29, find the probability that, in a random sample of four 
Americans ages 18–44, at least one of them smokes.

(The solution is shown in Appendix A.)
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282 Chapter 5 Probability

Approximating Probabilities for Dependent events
When the sample size is small compared to the population size, we can estimate the 
probability of a dependent event as if it were independent. The question is: How small 
is a small sample? We will use the following 1% Guideline.

4

The 1% Guideline
Suppose successive draws, such as those for a random sample, are being made from a 
population. If the sample size is no larger than 1% of the size of the population, then the 
probability of dependent successive draws from the population may be approximated 
using the assumption that the draws are independent.

The Gardasil vaccine
In the Section 5.2 exercises, we found the probability that a randomly chosen 
patient completed the treatment to be (469∕1413) ≈ 0.3319. Suppose we take 

a random sample of size n = 2 patients.

a. Calculate the probability that both patients complete the treatment, using 
sampling without replacement.

b. Confirm that the 1% Guideline applies.

c. Approximate the probability that both patients complete the treatment using the 
1% Guideline.

d. Find the approximation error by comparing your answers from (a) and (c).

Solution
Define the following events:

A: First patient completes the treatment

B: Second patient completes the treatment

a. We have PsAd 5 s469/1413d. Then, given that the first patient completed the 
treatment, we have, by sampling without replacement, PsB u Ad 5 s468/1412d. 
Then the Multiplication Rule gives us P(A and B) = P(A) · P(B given A ) = 
(469/1413) · (468/1412)≈ 0.110012. 

b. The sample of size 2 represents 2
1413 = 0.0014 = 0.14% of the population. Thus, 

the 1% Guideline applies, and we may treat the successive draws as independent.

c. Thus, we can use the Multiplication Rule for Independent Events to solve this 
problem.

P(A and B) = P(A) · P(B) = (469/1413)(469/1413) = 0.110169

d. The approximation error, the difference between (a) and (c), is 0.110169 2  
0.110012 = 0.000157. For most applications, this small approximation error is 
acceptable.

examPle 30  Applying the 1% Guideline
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The 1% Guideline is also helpful 
when we do not know the size of 
the population, but may presume 
that the population is very large 
compared to the sample size.

NOW YOU CAN DO
Exercises 75–78.

Bayes’ rule
When new information becomes available, our estimates of probability need to be 
revised to reflect the presence of the new information. An English Presbyterian Minis-
ter, Thomas Bayes (1702−1761) developed a rule, called Bayes’ rule, for updating 
previous probabilities using new information to arrive at revised probabilities.

5

case  
sTudy
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2835.3 Conditional Probability

We apply Bayes’ Rule in the following example.

Bayes’ rule
For any two events A and B, 

P sA given Bd 5
P sAd ? P sB given Ad

P sAd ? P sB given Ad 1 P sACd ? P sB given ACd

examPle 31  Bayes’ rule

The Gardasil vaccine
Table 24 contains a contingency table (crosstabulation) of the variables com-
pleted and insurance type for the data set Gardasil.12 

Table 24 Contingency table of the variables completed and insurance type

Insurance type

Hospital- 
based

Medical 
assistance Military Private payer Total

No 45 220 209 470  944

Completed Yes 39  55 122 253  469

Total 84 275 331 723 1413

Define the following events:

M: Insurance type = Military

C: Completed the vaccination treatment

Use Bayes’ Rule to find the probability that a randomly selected patient used military 
insurance, given that he or she completed the treatment.

Solution
We are interested in the probability P(M given C). Substituting M for A and C for B in 
the formula for Bayes’ Rule, we obtain:

PsM given Cd 5
PsMd ? PsC given Md

PsMd ? PsC given Md 1 PsMCd ? PsC given MCd

From Table 24, we have P(M) 5 331
1413 and P(C given M) 5 122

331. The event MC consists 
of all other insurance types besides military. So we have P(MC) 5 1082

1413, and P(C given 
MC) 5 347

1082. Thus, 

PsM given Cd 5

331

1413
?

122

331

331

1413
?

122

331
1

1082

1413
?

347

1082

5

122

1413

122

1413
1

347

1413

5
122

469
< 0.26

Note that this result is confirmed by the direct calculation of P(M u C) using Table 24, which 
is the single cell of 122 military completers divided by the total number of completers.

YOUR TURN
 #20

Using Table 24 and Bayes’ Rule, find the probability that a randomly selected patient 
used hospital-based insurance, given that he or she completed the treatment.

(The solution is shown in Appendix A.)

NOW YOU CAN DO
Exercises 105–108.

case  
sTudy
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284 Chapter 5 Probability

examPle 32  The eLiSA test for the presence of hiv

The ELISA test is used to screen blood for the presence of HIV. Like most  
diagnostic procedures, the test is not foolproof.
● When a blood sample contains HIV, the ELISA test will give a positive  

result 99.6% of the time. That is, the false-negative rate, the percentage of  
tests returning a negative result when the HIV virus is actually present, is  
1 2 0.996 = 0.004.

● When the blood does not contain HIV, the ELISA test will give a negative  
result 98% of the time. That is, the false-positive rate, the percentage of  
tests returning a positive result when the HIV virus is not actually present, is  
1 2 0.98 = 0.02.

A positive result means that the test says that the person has the HIV infection. A 
negative result means that the test says that the person does not have the virus. The 
prevalence rate for HIV in the general population is 0.5%. That is, 5 of 1000 persons 
in the general population have HIV.

Suppose we have samples of blood from 100,000 randomly chosen people.

Problem 1. How many people in the sample of 100,000 have HIV? How many  
do not?

Solution
The prevalence rate of 0.5% means that 0.005 (100,000) = 500 people in the sample 
have HIV. The remainder—99,500—do not.

Problem 2. A positive result is given 99.6% of the time for blood containing HIV. 
For the 500 people with HIV, how many positive results will the ELISA test return? 
How many of the 500 people with HIV will receive a negative result?

Solution
The ELISA test will return a positive result for 0.996 (500) = 498 of the 500 people. 
Thus, two people who actually have HIV will receive a test result indicating that they 
do not have the virus.

Problem 3. A negative result is given 98% of the time for blood without HIV. For 
the 99,500 people without HIV, how many negative results will the ELISA test return? 
Positive results?

Solution
The ELISA test will return a negative result for 0.98 (99,500) = 97,510 of the 99,500 
people without HIV. The remaining 2%, or 1990 people, will receive positive ELISA 
test results, even though they do not have the virus.

We can use the counts we found to fill in Table 25.

Table 25 ELISA test contingency table

In reality

ELISA test results Person has HIV Person does not have HIV Total

Positive 498 1,990   2,488

Negative 2 97,510  97,512

Total 500 99,500 100,000
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2855.3 Conditional Probability

We will use the information in the ELISA test contingency table to solve Problems 4 
and 5. If a person is chosen at random from the sample of 100,000, define the following 
events:

A:  Person has HIV.

AC:   Person does not have HIV.

Pos:    ELISA test returned positive results.

Neg: ELISA test returned negative results.

Problem 4. What is the probability that a randomly chosen person actually does 
have HIV, given that the ELISA results are negative? In other words, find P(A u Neg).

Solution

PsA given Negd 5
NsA and Negd

N sNegd
5

2

97,512
< 0.0000205

Problem 5. What is the probability that a randomly chosen person actually does 
not have HIV, given that the ELISA test results are positive? In other words, find 
P(AC given Pos).

Solution

PsAC given Posd 5
NsAC given Posd

N sPosd
5

1990

2488
< 0.7998 < 0.80

Section 5.3 Summary
1. Section 5.3 discusses conditional probability P(B given 
A), which is the probability of an event B given that an event 
A has occurred.
2. We can compare P(B given A) to P(B) to determine 
whether the events A and B are independent. Events are 
independent if the occurrence of one event does not affect 
the probability that the other event will occur.
3. The Multiplication Rule for Independent Events is the 
product of the individual probabilities. Sampling with 

replacement is associated with independence, whereas 
sampling without replacement means that the events are not 
independent.
4. We can use the 1% Guideline for approximating 
probabilities of dependent events.
5. Bayes’ Rule allows us to revise probabilities of events in 
light of new data.

Which Error Is More Dangerous?
In Problems 4 and 5, we examined the probabilities of the two ways that the ELISA 
test can be wrong. Which error do you think is more dangerous? P(A given Neg) 
represents the probability that HIV is present, even though the ELISA test says 
otherwise. P(AC given Pos) represents the probability that HIV is not present, even 
though the ELISA test says it is present. The designers of the ELISA test worked 
hard to reduce the false-negative rate P(A given Neg) to as low a level as possible. 
They rightly considered that it is the more dangerous type of error because of the 
epidemic nature of the illness. A person who receives a false-negative ELISA result 
could spread the infection further. Therefore, the designers tried to keep this prob-
ability as low as they could.

There is a price to be paid, however, which is the high false-positive rate, 
P(AC given Pos), a very high 80%. Thus, if a random person receives a positive 
ELISA test result, the probability that the person does not have HIV is 80%. When 
the ELISA test comes back positive, a second batch of tests that have a more reason-
able false-positive rate is usually administered.

Developing Your 
Statistical Sense
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Section 5.3 Exercises
ClarifyinG the ConCepts

 1. Suppose you are the coach of a football team, and your 
star quarterback is injured. (p. 274)

a. Does the injury affect the chances that your team will 
win the big game this weekend? 

b. How would you describe this situation in the 
terminology presented in this section?

 2. Write a sentence or two about a situation in your life 
similar to Exercise 1, where the probability of some event 
was affected by whether or not some other event occurred. 
(p. 274)
 3. Explain clearly the difference between P(A and B) and 
P(A given B). (p. 272)
 4. Give an example from your own experience of two 
events that are independent. Describe how they are 
independent. (p. 274)
 5. Picture yourself explaining the Gambler’s Fallacy to 
your friends. How would you explain the Gambler’s Fallacy 
in your own words? (p. 275)
 6. Explain why two events, A and B, cannot have the 
following characteristics: P(A) = 0.25, P(B) = 0.25, and 
P(A and B) = 0.30. (p. 272)
 7. Explain why each of the following events is either 
dependent or independent: (p. 277)

a. Drawing a ball from a box, replacing it, and then 
drawing a second ball

b. Drawing a ball from a box, not replacing it, and then 
drawing a second ball

 8. Explain why the following events are either dependent or 
independent, and provide support for your assertion: (p. 277)

a. Tossing a coin and drawing a card from a deck of 
playing cards

b. Drawing a card from a deck, not replacing it, and 
drawing another card

praCtiCinG the teChniques

CheCK it out!

to do Check out topic
Exercises 9–32 Example 19 Conditional probability
Exercises 33–52 Example 20 Determining whether 

two events are 
independent

Exercises 53–58 Example 22 Multiplication Rule
Exercises 59–66 Example 23 Multiplication Rule for 

two independent events
Exercises 67–70 Example 24 Sampling with 

replacement
Exercises 71–74 Example 25 Sampling without 

replacement
Exercises 79–84 Example 26 Determining 

independence using the 
alternative method

•

to do Check out topic
Exercises 85–92 Example 27 Conditional probability 

for mutually exclusive 
events

Exercises 93–100 Example 28 Multiple rule for n 
independent events

Exercises 100–104 Example 29 Solving an “at least” 
problem

Exercises 75–78 Example 30 Applying the 1% 
Guideline

Exercises 105–108 Example 31 Bayes’ Rule

Table 26 presents a sample of 10 threatened and endangered 
mammals, and their continents. The contingency table for 
this data is given in Table 27.

taBle 26 endangered and threatened mammals

species Continent
endangered or 
threatened?

Desert Bandicoot Australia Endangered

Grizzly Bear North America Threatened

Chimpanzee Africa Endangered

African elephant Africa Threatened

Koala Australia Threatened

Mountain gazelle Africa Endangered

Canada Lynx North America Threatened

Ocelot North America Endangered

Bighorn sheep North America Endangered

White rhino Africa Endangered

taBle 27 Contingency table of threatened and 
endangered species

africa australia
north 

america total

threatened 1 1 2 4
endangered 3 1 2 6

total 4 2 4 10

A mammal is to be chosen at random. Define the following 
events:

A: Continent is Africa
B: Continent is Australia
C: Continent is North America
E: Mammal is endangered
T: Mammal is threatened

For Exercises 9–22, use Table 27 to find the indicated 
probabilities.
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2875.3 Conditional Probability

 9. The mammal is from Africa, given that it is endangered, 
P(A given E)
10. P(B given E)
11. P(C given E)
12. P(A given T)
13. P(B given T)
14. P(C given T)
15. The mammal is endangered, given that it is from Africa, 
P(E given A)
16. P(E given B)
17. P(E given C)
18. P(T given A)
19. P(T given B)
20. P(T given C)
21. Compare P(E given A) and P(T given A). Among the 
mammals from Africa, is the higher proportion endangered 
or threatened? 
22. Compare P(A given E), P(B given E), and P(C given E). 
Among the endangered animals, which continent has the 
highest proportion of mammals? 

Use the contingency table in Table 28 to find the indicated 
probabilities for Exercises 23–26. A student is chosen at 
random. Define the following events:

U: Undergrad, G: Graduate student, D: Prefers desktops 
for email, S: Prefers smartphones for email.

taBle 28 Contingency table of D and s versus u and G

Desktops smartphones total
undergrads 2  4  6

Graduate students 3  6  9

total 5 10 15

23. Student prefers desktops for email, given student is an 
undergrad, P(D given U)
24. P(D given G)
25. P(S given U)
26. P(S given G)

Use the contingency table in Table 29 to find the indicated 
probabilities for Exercises 27–32. A person is chosen at 
random. Define the following events:

U: Undergrad, G: Graduate student, P: Parent, D: Prefers 
desktops for email, S: Prefers smartphones for email.

taBle 29 Contingency table of D and s versus u, G, 
and p

Desktops smartphones total
undergrads  2  4  6

Graduate students  3  6  9

parents  5  0  5

total 10 10 20

27. Student prefers desktops for email, given student is an 
undergrad, P(D given U)

28. P(D given G)
29. P(D given P)
30. P(S given U)
31. P(S given G)
32. P(S given P)

For Exercises 33–38, refer to your work in Exercises 9–22. 
Use the strategy for determining whether two events are 
independent (page 274) to determine whether the following 
pairs of events are independent:
33. Species is from Africa, and the species is endangered,  
A and E
34. B and E
35. C and E
36. A and T
37. B and T
38. C and T

For Exercises 39–42, refer to your work in Exercises 23–26. 
Use the strategy for determining whether two events are 
independent (page 274) to determine whether the following 
pairs of events are independent:
39. D and U
40. D and G
41. S and U
42. S and G

For Exercises 43–48, refer to your work in Exercises 27–32. 
Use the strategy for determining whether two events are 
independent (page 274) to determine whether the following 
pairs of events are independent:
43. D and U
44. D and G
45. D and P
46. S and U
47. S and G
48. S and P
49. Refer to Exercises 33–38. How would you respond if 
someone claimed that whether a species was threatened or 
endangered did not depend on the continent from which the 
species came?
50. In Exercise 49, which probabilities would you use to 
support your argument?
51. Refer to Exercises 39–42. Suppose someone claimed 
that whether a student preferred a desktop or a smartphone 
for email depended on whether the student was an undergrad 
or graduate student. How would you respond?
52. Refer to Exercises 43–48. Suppose someone claimed 
that whether a person preferred a desktop or a smartphone 
for email depended on whether the person was an undergrad 
or a parent. How would you respond?

For Exercises 53–58, use the Multiplication Rule to find the 
indicated probability.
53. The National Center for Education Statistics reports 
that 71% of college students applied for federal financial 
aid. Of those who applied for federal aid, 47.5% were male. 
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Choosing a student at random, what is the probability of 
selecting a male who applied for federal financial aid? 
54. Of all the police precincts in New York City, 32.89% are 
in Brooklyn. Of the precincts in Brooklyn, 56% are in South 
Brooklyn. Find the probability of selecting a police precinct 
in South Brooklyn.
55. Thirty percent of students at a particular college take 
statistics. Ninety percent of students taking statistics at the 
college pass the course. What is the probability that a student 
will take statistics and pass the course?
56. Fifty percent of students at a particular college are 
commuters. Of those, 10% bike to school. Find the 
probability that a student is a commuter and bikes to  
school.
57. Twenty-five percent of the nursing students at a 
particular college are male. Of these, 50% are taking a 
biology course this semester. Calculate the probability that a 
nursing student is a male and is taking a biology course this 
semester.
58. Thirty percent of the statistics students at a particular 
college have taken advantage of the college tutoring 
program. After doing so, 80% of them received a higher 
score on the next exam. Find the probability that a statistics 
student has taken advantage of the college tutoring program 
and has received a higher score on the next exam.

The National Center for Education Statistics reports the 
following statistics for surveys of 12,320 female college 
students and 9,184 male college students:

● 36% of females work 16–25 hours per week
● 38% of males work 16–25 hours per week

A random sample of n = 2 college students is taken. Define 
the following events:

F1: 1st draw is a female who works 16–25 hours
F2: 2nd draw is a female who works 16–25 hours
M1: 1st draw is a male who works 16–25 hours
M2: 2nd draw is a male who works 16–25 hours

For Exercises 59–66, use the Multiplication Rule  
for Independent Events to calculate the indicated 
probabilities:
59. P(F1 and F2)
60. P(F1 and M2)
61. P(M1 and F2)
62. P(M1 and M2)
63. P(F2 given F1)
64. P(M2 given F1)
65. Compare P(F1 and F2) with P(F2 given F1). Why is this 
so?
66. Compare P(F1 and M2) with P(M2 given F1). Why is 
this so?

For Exercises 67–70, suppose we sample two cards at 
random and with replacement from a deck of cards. Define 
the following events: R1: Red card observed on the first 
draw, R2: Red card observed on the second draw, H1: Heart 
observed on the first draw, H2: Heart observed on the second 
draw. Find the following probabilities:

67. P(R1 and R2).
68. P(H1 and H2).
69. P(R1 and H2).
70. P(H1 and R2).

For Exercises 71–74, suppose we sample three cards at 
random and without replacement from a deck of cards. 
Define the same events as for Exercises 67–70, and define 
event R3 as Red card observed on the third draw, and define 
event H3 as Heart observed on the third draw.
71. P(H1 and R2 and R3).
72. P(H1 and H2 and R3).
73. P(R1 and R2 and R3).
74. P(H1 and H2 and H3).

Use the following information for Exercises 75–78. The 
College Board reports that 48% of the 1.5 million students 
who took the Natural Sciences subject exam in 2014 had 
taken 4 years of high school science. 
75. If we take a sample of the following numbers of 
students, verify that the 1% Guideline applies:

a. n = 2 students
b. n = 3 students
c. n = 5 students

For Exercises 76–78, use the 1% Guideline to approximate 
the probability that the indicated number of students who 
took the Natural Sciences subject exam had taken four years 
of high school science.
76. n = 2 students
77. n = 3 students
78. n = 5 students

Table 30 represents the New York Times Best-Seller List  
for manga (a type of graphic novel), for the week of  
August 24, 2014. Table 31 contains a contingency table  
of this data, for the publisher and the weeks on the best-
seller list. Use this information for Exercises 79–88.

taBle 30 New York Times Best-seller list for manga, 
week of august 24, 2014

Manga title publisher
Weeks 
on list

Crimson Spell VIZ Media  1

Bleach VIZ Media  2

Deadman Wonderland VIZ Media  1

Fairy Tail Kodansha  1

Loveless VIZ Media  1

Food Wars! VIZ Media  2

Attack on Titan: No Regrets Kodansha  8

Rosario + Vampire VIZ Media  2

Dragonar Academy Seven Seas  2

Attack on Titan Kodansha 62

Source: NYTimes.com.
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taBle 31 Contingency table of manga publisher and 
weeks on best-seller list

ViZ Media Kodansha seven seas total

1 Week 3 1 0  4

2 Weeks 3 0 1  4

.2 Weeks 0 2 0  2

total 6 3 1 10

A manga title is to be selected at random. Define the 
following events:

V: Manga title is published by VIZ Media
K: Manga title is published by Kodansha
A: Manga title has been on list for one week.
B: Manga title has been on list for two weeks.
C: Manga title has been on list for more than two weeks.

For Exercises 79–84, use the alternative method for 
determining independence (page 279) to determine whether 
the following pairs of events are independent:
 79. V and A
 80. K and A
 81. V and B
 82. K and B
 83. V and C
 84. K and C

For Exercises 85–88, determine whether the following 
events are independent. Note that the events are mutually 
exclusive:
 85. V and K
 86. A and B
 87. A and C
 88. B and C
 89. Suppose P(X and Y) = 0, for events X and Y. State 
whether X and Y are independent.
 90. Define the following events: A = salary $50,000 or 
more, B = salary less than $50,000. Are A and B 
independent? Why?
 91. The intersection between events W and Z is empty.  
Then is it true or not true that P(W and Z ) = P(W  ) · P(Z )? 
Explain.
 92. Define event W: team wins. Are W and WC 
independent? Why?

For Exercises 93–96, use the Multiplication Rule for n 
Independent Events to find the probabilities. Define E: 
observe an even number on a toss of a fair die.
 93. E occurs on three successive tosses.
 94. E occurs on four successive tosses.
 95. E occurs on five successive tosses.
 96. E occurs on 10 successive tosses.

For Exercises 97–100, define H: observe a number greater 
than 3 on a toss of a fair six-sided die. Find the following 
probabilities:
 97. That H occurs at least once in three tosses
 98. That H occurs at least once in four tosses
 99. That H occurs at least once in five tosses
100. That H occurs at least once in 10 tosses

Google reports that 50% of incoming emails to Gmail are 
encrypted.13 For the random samples of size n emails in 
Exercises 101–104, find the probability that at least one of 
the emails is encrypted.
101. n = 2 
102. n = 3 
103. n = 4 
104. n = 5 

For Exercises 105–108, use Bayes’ Rule to find P(A u B) for 
the indicated probabilities.
105. P(A) = 0.5, P(AC) = 0.5, P(B u A) = 0.3, P(B u AC) = 0.5
106. P(A) = 0.3, P(AC) = 0.7, P(B u A) = 0.25, P(B u AC) = 0.2
107. P(A) = 0.4, P(AC) = 0.6, P(B u A) = 0.25, P(B u AC) = 0.4
108. P(A) = 0.9, P(AC) = 0.1, P(B u A) = 0.5, P(B u AC) = 0.2

applyinG the ConCepts

109. Mobile youtube Watchers. YouTube reports that 
40% of users access YouTube with a mobile device.

a. Find the probability that two randomly selected 
YouTube watchers are using mobile devices.

b. Find the probability that three randomly selected 
YouTube watchers are all using mobile devices.

c. Find the probability that five randomly selected 
YouTube watchers are all using mobile devices.

d. Find the probability that at least one of four 
randomly selected YouTube watchers is using a 
mobile device.

110. China’s Groundwater problem. The Web site http://
chinawaterrisk.org reports that 60% of China’s underground 
water sources are polluted.

a. Find the probability that two randomly selected 
underground water sources are polluted.

b. Find the probability that three randomly selected 
underground water sources are polluted.

c. Find the probability that at least one of three 
randomly selected underground water sources is 
polluted.

111. social Media and Video Games. A study14 reported 
that 60% of social media users play video games. Suppose 
this study was based on 10 social media users, and we 
sample three of these without replacement. Find the 
following probabilities:

a. The first social media user plays video games.
b. The second social media user plays video games, 

given that the first social media user plays video 
games.

c. The third social media user plays video games, 
given that the first two social media users play 
video games.

associate’s Degree or Bachelor’s Degree? Use the 
following information for Exercises 112–114: In its survey 
of undergraduate college students, the National Center 
for Educational Statistics reported the frequencies in the 
following contingency table for the number of students in an 
Associate’s degree program and the number of students in a 
Bachelor’s degree program, along with the student’s gender. 
One student is selected at random.
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associate’s Bachelor’s total
Female 5,276 5,491 10,767

Male 3,819 4,483 8,302

Total 9,095 9,974 19,069

112. Find the following probabilities:
a. Student is in an Associate’s degree program.
b. Student is in a Bachelor’s degree program.
c. Student is female.
d. Student is male.

113. Calculate the following conditional probabilities:
a. Student is in an Associate’s degree program, given 

that the student is female.
b. Student is in an Associate’s degree program, given 

that the student is male.
c. Student is in a Bachelor’s degree program, given 

that the student is female.
d. Student is in a Bachelor’s degree program, given 

that the student is male.
114. Determine whether the following events are independent:

a. Being in an Associate’s Degree program, and being 
female

b. Being in an Associate’s degree program, and  
being male

c. Being in a Bachelor’s degree program, and being 
female

d. Being in a Bachelor’s degree program, and being 
male

More Millenials in College. The following contingency 
table contains the results of a survey by the Pew Research 
Center comparing the number of Millennials in 2013 
who completed a Bachelor’s degree versus the number 
of Generation X’ers in 1995 who completed a Bachelor’s 
degree. Use this information for Exercises 115–118.

Completed 
Bachelor’s  
degree or 

more

Completed 
less than a 
Bachelor’s 

degree total
Millennials: 2013  6,686 11,662 18,348

Gen X’ers: 1995  4,458 10,897 15,355

total 11,144 22,559 33,703

115. Find the probability that a randomly chosen survey 
respondent has the following characteristics:

a. Completed a Bachelor’s degree or more, P(B).
b. Is a Millennial, P(M).

116. Find the following probabilities for a randomly 
selected survey respondent:

a. P(B and M)
b. P(B or M)
c. P(BC)
d. P(MC)

117. Find the following conditional probabilities for a 
randomly chosen survey respondent:

a. P(B given M)
b. P(BC given M)

c. P(B given MC)
d. P(BC given MC)

118. Based on your answers to the three previous exercises, 
state whether completing a Bachelor’s degree is independent 
of being a Millennial.

happiness in Marriage. Use the following information for 
Exercises 119–121: The General Social Survey tracks trends 
in American society through annual surveys. The married 
respondents were asked to characterize their feelings about 
being married. The results, crosstabulated with gender, are 
shown in the following table.

happiness of marriage

Very 
happy

pretty 
happy

not too 
happy total

Gender
Male 242 115  9 366

female 257 149 17 423

total 499 264 26 789

119. Find the probabilities that a randomly chosen person 
has the following characteristics:

a. Is female, P(F )
b. Is male, P(M )
c. Is not too happily married, P(Not)

120. Find the probabilities that a randomly chosen person 
has the following characteristics:

a. Is female and not too happily married, P(F and Not)
b. Is male and not too happily married, P(M and Not)

121. Are gender and being not too happily married 
independent? Why or why not?
122. acceptance sampling. You are in charge of 
purchasing for a large computer retailer. Your wholesaler 
delivers computers to you in batches of 100. You either 
accept or reject an entire batch based on a random sample of 
two computers: if both computers you sample are defective, 
then you reject the entire batch. Suppose that (unknown to 
you, of course) there are 10 defective computers in the batch 
of 100 computers.

a. Should you conduct your sampling with or without 
replacement? Why?

b. What is the probability that the first computer you 
select is defective?

c. What is the probability that the second computer 
you select is defective, given that the first was 
defective, if you sample without replacement?

d. What is the probability that you will accept the 
batch?

e. What is the probability that you will reject the batch?
123. acceptance sampling. Refer to the previous exercise. 
Usually, you accept each batch of computers from this 
wholesaler.

a. Do you think that is a wise move, considering that 
10% of their product is defective? 

b. How could you make your test stricter so that there 
is a smaller chance of accepting a batch with 10% 
defectives?
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Vaccine Completion and practice type. 
Case study: the Gardasil Vaccine. Here is a 
contingency table of those who completed the 
vaccine treatment and the (medical provider’s) 

practice type. Use this information for Exercises 124–127. 

practice type

pediatric family
oB/
Gyn total

Completed
no 353 259 332  944
yes 162 106 201  469

total 515 365 533 1413

124. Find the probability that a randomly chosen patient has 
the following characteristics:

a. Visited a family-type practice, P(F)
b. Visited an OB/GYN-type practice, P(G)
c. Completed the treatment, P(C)

125. Find the probabilities that a randomly chosen patient 
has the following characteristics: 

a. Visited a family practice and completed the treatment
b. Visited an OB/GYN practice and completed the 

treatment
126. Find the following conditional probabilities for a 
randomly chosen patient:

a. Completed the treatment, given that the patient 
visited a family practice, P(C u F)

b. Completed the treatment, given that the patient 
visited an OB/GYN practice, P(C u G)

127. Based on your answers to the three previous exercises, 
state whether the following are independent:

a. Visiting a family practice and completing the 
treatment

b. Visiting an OB/GYN practice and completing the 
treatment

WorKinG With larGe Data sets

case  
sTudy

Chapter 5 Case study: the Gardasil Vaccine. 
Open the data set Gardasil. We shall explore some 
probabilities about the patient completion of the 
vaccination regime and the age group of the patient 

(“0” = 11–17 years old; “1” = 18–26 years old), using the 
tools and techniques we have learned in this section. Use 
technology to do Exercises 128–131. Define the following 
events: gardasil

C: Completed treatment 
A: Patient is 11–17 years old 
B: Patient is 18–26 years old 

128. Construct a contingency table (crosstabulation) of age 
group versus whether or not they completed the treatment. 
129. Use the contingency table to calculate the following 
probabilities:

a. Completed the treatment
b. Patient is 11–17 years old.
c. Patient is 18–26 years old.
d. Completed the treatment, and the patient is  

11–17 years old
e. Completed the treatment, and the patient is  

18–26 years old
f. Completed the treatment, given that patient is  

11–17 years old
g. Completed the treatment, given that patient is  

18–26 years old
130. Based on your work in the previous exercise, determine 
whether the following events are independent:

a. Completing the treatment, and the patient being 
11–17 years old

b. Completing the treatment, and the patient being 
18–26 years old.

131. Which age group had a higher proportion finishing  
the treatment? Do you think this difference reflects a true 
difference in the age groups for all patients, or is it simply the 
luck of the draw in this sample of patients?

Multiplication rule for counting
Let us begin with an example illustrating a general rule of counting.

1

5.4 Counting Methods

OBjecTiveS By the end of this section, I will be able to . . .
1 Apply the Multiplication Rule for Counting to solve certain counting 

problems.
2 Use permutations and combinations to solve certain counting problems.
3 Compute probabilities using combinations.

2915.4 Counting Methods

case  
sTudy

Counting methods allow us to solve a range of problems, including how to compute 
certain probabilities.
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292 Chapter 5 Probability

examPle 33  Design your own T-shirt

A store at the local mall allows customers to design their own T-shirts. The store offers 
the following options to its customers:

● sleeve type: Long-sleeve or short-sleeve

● Color: White, black, or red

● image: Stock picture or uploaded photo

List the possible T-shirt options.

Solution
Figure 18 is a tree diagram that shows all the different T-shirts that can be designed. 
Two choices are available for the type of sleeve. For each sleeve type, there are three 
choices for color. For each color, there are two choices of image: stock picture or 
uploaded photo. Altogether, customers have a choice from among

2 · 3 · 2 = 12

different T-shirt options.

B
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FiGure 18  
Tree diagram for the  

different T-shirt options.

Sleeve type Color Image T-shirt

Long-sleeve, black, stock picture 

Long-sleeve, black, uploaded photo

Long-sleeve, red, stock picture

Long-sleeve, red, uploaded photo

Black

Stock picture

Uploaded photo

Red

Stock picture

Uploaded photo

Long-sleeve, white, stock picture

Long-sleeve, white, uploaded photo

Stock picture

White

Uploaded photo

Long-sleeve 

Short-sleeve, black, stock picture

Short-sleeve, black, uploaded photo

Short-sleeve, red, stock picture

Short-sleeve, red, uploaded photo

Black

Stock picture

Uploaded photo 

Red

Stock picture

Uploaded photo 

Short-sleeve, white, stock picture

Short-sleeve, white, uploaded photo

Stock picture

White

Uploaded photo

Short-sleeve

NOW YOU CAN DO
Exercises 7–10.
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2935.4 Counting Methods

We can generalize the result from Example 33 as the Multiplication rule for 
Counting.

Multiplication rule for counting
Suppose an activity consists of a series of events in which there are a possible outcomes 
for the first event, b possible outcomes for the second event, c possible outcomes for the 
third event, and so on. Then the total number of different possible outcomes for the series 
of events is

a · b · c ...

examPle 34  counting with repetition: Famous initials

examPle 35  counting without repetition: intramural singles tennis

Some Americans in history are uniquely identified by their initials. For example, “JFK” 
stands for John Fitzgerald Kennedy, and “FDR” stands for Franklin Delano Roosevelt. 
How many different possible sets of initials are there for people with a first, middle, 
and last name?

Solution
Let us consider the three initials as an activity consisting of three events. Note that a 
particular letter may be repeated, as in “AAM” for A. A. Milne, author of Winnie the 
Pooh. Then there are a = 26 ways to choose the first initial, b = 26 ways to choose the 
second initial, and c = 26 ways to choose the third initial. Thus, by the Multiplication 
Rule for Counting, the total number of different sets of initials is

26 · 26 · 26 = 17,576

A local college has an intramural singles tennis league with five players: Ryan, Megan, 
Nicole, Justin, and Kyle. The college presents a trophy to the top three players in the 
league. How many different possible sets of three trophy winners are there?

Solution
The major difference between Example 34 and this example is that, in this example 
there can be no repetition. Ryan cannot finish in first place and second place. So we 
proceed as follows: Five possible players could finish in first place, so a = 5. Now 
there are only four players left, one of whom will finish in second place, so b = 4. 
That leaves only three players, one of whom will finish in third place, giving c = 3. 
Thus, by the Multiplication Rule for Counting, the number of different possible sets 
of trophy winners is

5 · 4 · 3 = 60

NOW YOU CAN DO
Exercises 11 and 12.

Note: To summarize the key 
difference between Examples 34 
and 35: If repetitions are allowed, 
then a  b  c. If repetitions are 
not allowed, then the numbers 
being multiplied decrease by one 
from left to right.

YOUR TURN
 #21

For the situation in Example 35, suppose there are six players, and the college presents 
a trophy to the top four players in the league. How many different possible sets of four 
trophy winners are there?

(The solution is shown in Appendix A.)

NOW YOU CAN DO
Exercises 13 and 14.
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294 Chapter 5 Probability

The calculation in Example 36 leads us to introduce the factorial symbol, which 
is used for the counting rules we will learn in the remainder of this section.

examPle 36  Traveling salesman problem

A Southeast regional salesman has eight destinations that he must travel to this month: 
Atlanta, Raleigh, Charleston, Nashville, Jacksonville, Richmond, Mobile, and Jack-
son. How many different possible routes could he take?

Solution
The salesman has a = 8 different choices for where to go first. Once the first destina-
tion has been chosen, there are only b = 7 choices for where to go second. And once 
the first two destinations have been chosen, there are only c = 6 choices for where to 
go third, and so on. Thus, by the Multiplication Law for Counting, the number of dif-
ferent possible routes for the salesman is

a · b · c · d · e · f · g · h = 8 · 7 · 6 · 5 · 4 · 3 · 2 · 1 = 40,320

YOUR TURN
 #22

For the traveling salesman in Example 36, suppose there are ten destinations he must 
travel to. How many different possible routes could he take? 

(The solution is shown in Appendix A.)

NOW YOU CAN DO
Exercises 15 and 16.

For any integer n $ 0, the factorial symbol n! is defined as follows:
● 0! = 1
● 1! = 1
● n! = n(n – 1)(n – 2) ... 3 · 2 · 1

examPle 37  Factorials

Calculate the following factorials:

a. 2!  b. 3!  c. 4!  d. 5!  e. 6!  f. 7!  g. 8! 

Solution
a. 2! = 2 · 1 = 2

b. 3! = 3 · 2 · 1 = 6

c. 4! = 4 · 3 · 2 · 1 = 24

d. 5! = 5 · 4 · 3 · 2 · 1 = 120

e. 6! = 6 · 5 · 4 · 3 · 2 · 1 = 720

f. 7! = 7 · 6 · 5 · 4 · 3 · 2 · 1 = 5040

g. 8! = 8 · 7 · 6 · 5 · 4 · 3 · 2 · 1 = 40,320, as in Example 36

YOUR TURN
 #23

Find the following factorials:

a. 9!

b. 10!

(The solutions are shown in Appendix A.)

NOW YOU CAN DO
Exercises 17–22.
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2955.4 Counting Methods

Permutations and combinations2

examPle 38  Traveling to some but not all of the cities
Example 37 calculated the number of possible routes for traveling to n = 8 cities. 
However, suppose we are interested in traveling to some but not all of the cities? For 
example, suppose that the salesman is traveling to three of the eight cities. Find the 
number of possible routes.

Solution
Eight choices are available for the first city, seven choices for the second city, and six 
choices for the third city. The salesman is traveling to three cities only, so the number 
of possible routes is thus

8 · 7 · 6 = 336

This result may be rewritten using factorial notation, as follows:

8 ? 7 ? 6 5
8 ? 7 ? 6 ? s5 ? 4 ? 3 ? 2 ? 1d

s5 ? 4 ? 3 ? 2 ? 1d
5

8!

5!
5

8!

s8 2 3d!

Example 38 leads us to the following definition.

YOUR TURN
 #24

For the traveling salesman in Example 38, suppose there are 10 destinations, but he is 
traveling only to 5 of the 10 destinations. Find the number of possible routes. 

(The solution is shown in Appendix A.)

NOW YOU CAN DO
Exercises 23 and 24.

Permutations
A permutation is an arrangement of items, such that
● r items are chosen at a time from n distinct items.
● repetition of items is not allowed.
● the order of the items is important.
The number of permutations of n items chosen r at a time is denoted as n Pr and given by 
the formula

nPr 5
n!

sn 2 rd!

In Example 38, we are looking for the number of permutations of 8 cities taken 3 
at a time. We have n = 8, r = 3:

n
P

r
5

8
P

3
5

n!

sn 2 rd!
5

8!

s8 2 3d!
5

8!

5!
5 8 ? 7 ? 6 5 336

examPle 39  calculating numbers of permutations

Find the following numbers of permutations:
a. 5P2 b. 6P2 c. 6P6

Solution
a. 5P2 = 

5!

s5 2 2d!
5

5 ? 4 ? 3!

3!
5 20
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examPle 40  counting permutations: Secret Santas

“Secret Santa” refers to a method whereby each member of a group anonymously buys 
a holiday gift for another member of the group. Each person is secretly assigned to 
buy a gift for another randomly chosen person in the group. Suppose Jessica, Laverne, 
Samantha, and Luisa share a dorm suite and want to do Secret Santa this holiday 
season.

a. Verify that in this instance one woman purchasing a gift for another woman 
represents a permutation.

b. Calculate how many possible different permutations of gift buying there are for 
the four women.

Solution
a. ●    There are n = 4 women, and r = 2 people are associated with each gift (the 

giver and the receiver).
● Each person can buy only one gift, so repetition is not allowed.
● Finally, there is a difference between Jessica buying for Laverne and Laverne 

buying for Jessica. Thus, order is important, and thus, buying a gift 
represents a permutation.

b. The number of permutations is calculated as follows:

nPr = 4P2 = 
4!

s4 2 2d!
5

4 ? 3 ? 2!

2!
5 12

YOUR TURN
 #25

Find the following numbers of permutations:

a. 5P3   b. 6P4   c. 2P2

(The solution is shown in Appendix A.)

b. 6P2 = 
6!

s6 2 2d!
5

6 ? 5 ? 4!

4!
5 30

c. 6P6 = 
6!

s6 2 6d!
5

6 ? 5 ? 4 ? 3 ? 2 ? 1

0!
5 720

NOW YOU CAN DO
Exercises 25–32.

In a permutation, order is important. For example, in Example 40, there was a dif-
ference between Jessica buying a gift for Laverne and Laverne buying one for Jessica. 
However, what if we consider shaking hands instead? Then Jessica shaking hands with 
Laverne is considered the same as Laverne shaking hands with Jessica. Thus, some-
times order is not important. What is important here is the combination of Jessica and 
Laverne.

combinations
A combination is an arrangement of items in which
● r items are chosen from n distinct items.
● repetition of items is not allowed.
● the order of the items is not important.
The number of combinations of r items chosen from n different items is denoted as

nCr

Larose_3e_ch05.indd   296 16/06/15   5:14 PM



© 20
16

 W
.H. F

ree
man

 Co.

2975.4 Counting Methods

examPle 41  how many combinations in the intramural tennis league?

We return to the intramural singles tennis league at the local college. There are five 
players: Ryan, Megan, Nicole, Justin, and Kyle. Each player must play each other 
once.

a. Confirm that a match between two players represents a combination.

b. How many matches will be held?

Solution
a. Let {Ryan, Megan} denote a tennis match between Ryan and Megan. Note:

● There are r = 2 players chosen from n = 5 players.
● Each player plays each other player once, so repetition is not allowed.
● There is no difference between {Ryan, Megan} and {Megan, Ryan}, so order 

is not important.

Thus, a tennis match between two players represents a combination.

b. The list of all matches is as follows.

{Ryan, Megan} {Megan, Nicole} {Nicole, Justin}
{Ryan, Nicole} {Megan, Justin} {Nicole, Kyle}
{Ryan, Justin} {Megan, Kyle} {Justin, Kyle}
{Ryan, Kyle}

Thus, there are 5C2 = 10 possible matches of r = 2 players chosen from n = 5 players.

YOUR TURN
 #26

For the intramural league in Example 41, suppose there are 10 players. How many 
matches will be held? 

(The solution is shown in Appendix A.)

We saw in Example 39 that 5P2 = 20 and in Example 41 that 5C2 = 10. Permuta-
tions and combinations differ only in that ordering is ignored for combinations. To 
calculate the number of combinations nCr, we have to take into consideration how many 
different rearrangements there are of the same items. For example, in Example 41, 
there are r! = 2! = 2 rearrangements of the same players, such as {Ryan, Megan} and 
{Megan, Ryan}. Thus, 

5
C

2
5

5
P

2

2!
5

20

2
5 10

In general, the number of combinations can be computed as the number of permu-
tations divided by the factorial of the number of items chosen.

Note: Following are some special 
combinations you may find useful. 
For any integer n:

nCn = 1
nC0 = 1
nC1 = n

nCn–1 = n

Formula for the Number of combinations
The number of combinations of r items chosen from n different items is given by

nCr 5
n!

r!sn 2 rd!

For instance, in Example 41, the formula for the number of combinations is

s
C

2
5

5!

2!s5 2 2d!
5

5!

2!3!
5

5 ? 4 ? 3!

2 ? 1 ? 3!
5

20

2
5 10

Thus, the relation: 5C2 = 5P2  / 2! is verified.
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298 Chapter 5 Probability

examPle 42  calculating numbers of combinations

Find the following numbers of combinations:

a. 6C2   b. 6C3   c. 6C4

Solution
a. 

6
C

2
5

6!

2!s6 2 2d!
5

6 ? 5 ? 4!

2 ? 1 ? 4!
5

30

2
5 15

b. 
6
C

3
5

6!

3!s6 2 3d!
5

6 ? 5 ? 4 ? 3!

3 ? 2 ? 1 ? 3!
5

120

6
5 20

c. 
6
C

4
5

6!

4!s6 2 4d!
5

6!

s6 2 4d!4!
5

6 ? 5 ? 4!

2 ? 1 ? 4!
5

30

2
5 15

YOUR TURN
 #27

Find the following numbers of combinations:

a. 5C4   b. 5C3   c. 5C2

(The solutions are shown in Appendix A.)

NOW YOU CAN DO
Exercises 33–40.

examPle 43   calculating the number of permutations and combinations  
using technology

Use the TI-83/84 and Excel to calculate the following:

a. 9P6   b. 10C7

Solution
We use the instructions provided in the Step-by-Step Technology Guide at the end of 
this section (page 302).

a. From Figures 19a and 19b, we find that 9P6 = 60,480.

FiGure 19a TI-83/84 
permutation results.

FiGure 19b Excel permutation results.

FiGure 19c TI-83/84 
combination results.

FiGure 19d Excel combination results.

b. From Figures 19c and 19d, we find that 10C7 = 120.

Note that in (c), we used the commutative property of multiplication (a · b = b · a) and 
found that 6C4 = 6C2 = 15. In general, nCr = nCn–r for this reason.

Larose_3e_ch05.indd   298 16/06/15   5:14 PM



© 20
16

 W
.H. F

ree
man

 Co.

2995.4 Counting Methods

Sometimes we wish to find the number of permutations of items where some of 
the items are not distinct.

examPle 44  Permutations with nondistinct items

How many distinct strings of letters can we make by using all the letters in the word 
STATISTICS?

Solution
Each string will be 10 letters long and include 3 S’s, 3 T’s, 2 I’s, 1 A, and 1 C. The 10 
positions shown here need to be filled.

___ ___ ___ ___ ___ ___ ___ ___ ___ ___
 1 2 3 4 5 6 7 8 9 10

The string-forming process is as follows:

Step 1 Choose the positions for the three S’s.

Step 2 Choose the positions for the three T’s.

Step 3 Choose the positions for the two I’s.

Step 4 Choose the position for the one A.

Step 5 Choose the position for the one C.

There are 10C3 ways to place the three S’s in Step 1. Once Step 1 is done, seven 
slots are left, leaving 7C3 positions for the three T’s. Once Step 2 is done, four slots are 
left, so there are 4C2 ways to place the two I’s. Once Step 3 is done, only two slots  
are left, so there are only 2C1 ways to position the A. Finally, there is only 1C1 way to 
place the C.

Putting Steps 1–5 together, we calculate the number of distinct letter strings as

10
C

3
?

7
C

3
?

4
C

2
?

2
C

1
?

1
C

1
5

10!

3!7!
?

7!

3!4!
?

4!

2!2!
?

2!

1!1!
?

1!

1!0!

5
10!

3!3!2!1!1!
5

3,628,800

72

= 50,400

There are 50,400 distinct strings of letters that can be made using the letters in the 
word STATISTICS.

This example can be generalized in the following result.

Permutations of Nondistinct items
The number of permutations of n items of which n1 are of the first kind, n2 are of the 
second kind, …, and nk are of the kth kind is calculated as

n!
n! ? n2! ? Á ? nk!

where n = n1 + n2 +...+ nk.
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300 Chapter 5 Probability

acceptance sampling refers to the process of (1) selecting a random sample from 
a batch of items, (2) evaluating the sample for defectives, and (3) either accepting or 
rejecting the entire batch based on the evaluation of the sample.

examPle 45  Number of permutations of nondistinct items

examPle 46  Acceptance sampling uses combinations

Brandon brings a healthy snack to school each day, consisting of 5 carrot sticks,  
4 celery sticks, and 2 cherry tomatoes. If Brandon eats one item at a time, in how many 
different ways can he eat his snack?

Solution
We are seeking the number of permutations of n = 11 items, of which n1 = 5 are carrot 
sticks, n2 = 4 are celery sticks, and n3 = 2 are cherry tomatoes. Using the formula for 
the number of permutations of nondistinct items,

n!

n
1
! ? n

2
! ? n

3
!

5
11!

5! ? 4! ? 2!
5

39,916,800

120 ? 24 ? 2
5 6930

There are 6930 distinct ways in which Brandon can eat his snack.

Suppose we have a batch of 20 cell phones, of which, unknown to us, 3 are defective 
and 17 are nondefective; we will take a random sample of size 2 and evaluate both 
items once.

a. Are the arrangements in acceptance sampling permutations or combinations?

b. Find the number of ways that both sampled cell phones are defective.

Solution
a. Both permutations and combinations require the following:

● r items are chosen from n distinct items. Here, we are selecting r = 2 phones 
from a batch of n = 20.

● Repetition of the items is not allowed. Each item is evaluated only once.  
The difference between permutations and combinations is that, for 
permutations, order is important, whereas for combinations, order is not 
important. In acceptance sampling, the order of the items is not important. 
Thus, acceptance sampling uses combinations.

b. The number of ways of choosing two of the three defectives is

3
C

2
5

3!

2!s3 2 2d!
5

3 ? 2!

2! ? 1!
5 3

Selecting 2 defectives means that we are choosing 0 of the 17 nondefectives. The 
number of ways this can happen is

17
C

0
5

17!

0!s17 2 0d!
5

17!

1 ? 17!
5 1

By the Multiplication Rule for Counting, the number of ways that both sampled cell 
phones are defective is

3C2 · 17C0 = 3 · 1 = 3

NOW YOU CAN DO
Exercises 41 and 42.
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computing Probabilities using combinations
The counting methods we have learned in this section may be used to compute prob-
abilities. We assume that each possible outcome in a random sample is equally likely, 
and thus we use the classical method for assigning the probability of an event E:

PsEd 5
number of outcomes in E

number of outcomes in sample space
5

NsEd
NsSd

3

examPle 47 Probability using combinations: Acceptance sampling
Continuing with Example 46, if both cell phones in the sample of size 2 are defective, 
we will reject the batch and cancel our contract with the supplier.

a. What is the number of ways that both cell phones will be defective?

b. What is the number of outcomes in this sample space?

c. What is the probability that both cell phones will be defective?

Solution
a. From Example 46, the number of ways that both cell phones will be defective is

3C2 · 17C0 = 3 · 1 = 3

b. The number of outcomes in the sample space is given by the number of ways of 
selecting 2 cell phones out of a batch of 20; that is,

N(S ) = 20C2 = 
20!

2!s20 2 2d!
5

20 ? 19 ? 18!

2! ? 18!
5

380

2
5 190

c. Therefore, the probability that both cell phones will be defective is given by

P(Both defective) = 
number of ways both defective

number of outcomes in sample space
5

3

190
< 0.01579

examPle 48 Florida Lotto

You can win the jackpot in the Florida Lotto by correctly choosing all 6 winning num-
bers out of the numbers 1–53.

a. What is the number of ways of winning the jackpot by choosing all 6 winning 
numbers?

b. What is the number of outcomes in this sample space?

c. If you buy a single ticket for $1, what is your probability of winning the jackpot?

d. If you mortgage your house and buy 500,000 tickets, what is your probability of 
winning the jackpot (assuming that all the tickets are different)?

Solution
a. The number of ways of winning the jackpot by correctly choosing all 6 of the 

winning numbers and none of the losing numbers is

N(Jackpot) = 6C6 · 47C0 = 1 · 1 = 1
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b. The size of the sample space is

N(S ) = 53C6 = 
53!

6!s53 2 6d!
5

53 ? 52 ? 51 ? 50 ? 49 ? 48 ? 47!

6! ? 47!

= 
16,529,385,600

720
5 22,957,480

c. Therefore, if you buy a single ticket for $1, your probability of winning the 
jackpot is given by

P(Jackpot) = 
1

22,957,480
< 0.00000004356

d. If you buy 500,000 tickets and they are all unique, then your probability of 
winning becomes

P(Jackpot) = 
500,000

22,957,480
< 0.02178

This is because the unique tickets are mutually exclusive, and the Addition Rule for 
Mutually Exclusive Events allows us to add the probabilities of the 500,000 tickets. 
After mortgaging your $500,000 house and buying lottery tickets with the proceeds, 
there is a better than 97% probability that you will not win the lottery. 

STeP-By-STeP TechNOLOGy GuiDe: Factorials, Permutations, and combinations

TI-83/84
Factorials n!
Step 1 On the home screen, enter the value of n.
Step 2 Press MATH, highlight PRB, and select 4: ! (Figure 20).
Step 3 Press ENTER two times.
Permutations nPr and Combinations nCr

Step 1 On the home screen, enter the value of n.
Step 2 a. For permutations, press MATH, highlight PRB, and 
select 2:nPr.
b. For combinations, press MATH, highlight PRB, and select 3:nCr.

FiGure 20

Step 3 On the home screen, enter the value of r.
Step 4 Press ENTER (see Figure 19a and Figure 19c in  
Example 43).

EXCEL
Factorials n!
Calculate 9!
Step 1 Select an empty cell, and type = FACT(9).
Step 2 Press ENTER.

Permutations nPr

We illustrate Example 43a (page 298): 9P6.
Step 1 Select an empty cell and type = PERMUT(9,6).

Step 2 Press ENTER. See Figure 19b in Example 43 for the 
result.

Combinations nCr

We illustrate Example 43b (page 298): 10C7.
Step 1 Select an empty cell and type = COMBIN(10,7).
Step 2 Press ENTER. See Figure 19d in Example 43 for the 
result.

MINITAB
Factorials n!
Step 1 Click Calc > Calculator… 
Step 2 In Store result in variable, type C1. From Functions, 
choose Arithmetic, then double-click Factorial. Under Expression, 
replace number of items with n. Click OK.

Permutations nPr

We illustrate Example 43a (page 298): 9P6.
Step 1 Click Calc > Calculator…
Step 2 In Store result in variable, type C1. From Functions, 
choose Arithmetic, then double-click Permutations. Under 

Expression, replace number of items with 9 and number to 
choose with 6. Click OK. 

Combinations nCr

We illustrate Example 43b (page 298): 10C7.
Step 1 Click Calc > Calculator… 
Step 2 In Store result in variable, type C1. From Functions, 
choose Arithmetic, then double-click Combinations. Under 
Expression, replace number of items with 10 and number to 
choose with 7. Click OK. 
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Section 5.4 Summary
1. The Multiplication Rule for Counting provides the total 
number of different possible outcomes for a series of events. 
2. A permutation nPr is an arrangement in which

• r items are chosen from n distinct items.
• repetition of items is not allowed.
• the order of the items is important.

In a permutation, order is important. In a combination, order 
does not matter. A combination nCr is an arrangement in which

• r items are chosen from n distinct items.
• repetition of items is not allowed.
• the order of the items is not important.

3. Combinations may be used to calculate certain 
probabilities. For such problems, use the following steps:

step 1 Confirm that the desired probability involves a 
combination.
step 2 Find N(E ), the number of outcomes in event E.
step 3 Find N(S ), the number of outcomes in the 
sample space.
step 4 Assuming that each possible combination is 
equally likely, find the probability of event E as follows:

P(E ) = 
NsEd
NsSd

Section 5.4 Exercises
ClarifyinG the ConCepts

 1. What type of diagram is helpful in itemizing the 
possible outcomes of a series of events? (p. 292)
 2. Explain in words how 5! is calculated. (p. 294)
 3. What is the difference between a permutation and a 
combination? (pp. 295–296)
 4. Does 8P9 make sense? Explain why or why not.  
(p. 295)
 5. Describe in your own words what is meant by 
acceptance sampling. (p. 300)
 6. The counting methods that we have learned in this 
section may be used to compute probabilities. (p. 301)

a. For assigning probability, which method is used: 
classical, relative frequency, or subjective?

b. Referring to part (a), what assumption must be made 
to apply the method?

praCtiCinG the teChniques

 CheCK it out!

to do Check out topic
Exercises 7–10 Example 33 Tree diagrams
Exercises 11–12 Example 34 Counting with 

repetition
Exercises 13–14 Example 35 Counting without 

repetition
Exercises 15–16 Example 36 Traveling salesman 

problem, Part 1
Exercises 17–22 Example 37 Factorials
Exercises 23–24 Example 38 Traveling salesman 

problem, Part 2
Exercises 25–32 Example 39 Calculating numbers  

of permutations
Exercises 33–40 Example 42 Calculating numbers  

of combinations
Exercises 41–42 Example 45 Number of 

permutations of 
nondistinct items

•

 7. A pizza store offers the following options to its 
customers. Use a tree diagram to list all the possible options 
from which a customer may choose.

•	 Cheese: no cheese, regular cheese, double cheese
•	 Pepperoni: no pepperoni, regular pepperoni, double 

pepperoni
 8. An ice cream shop offers the following options to its 
customers. Use a tree diagram to list all the possible options 
from which a customer may choose.

•	 Ice cream: vanilla, chocolate, mint chocolate chip
•	 Toppings: hot fudge, butterscotch, sprinkles

 9. A particular baseball pitcher has to choose from the 
following options on each pitch. Use a tree diagram to list all 
the possible options.

•	 Type of pitch: fastball, curve, slider
•	 Horizontal position: inside corner, over the plate, 

outside corner
•	 Vertical position: high, low

10. A women’s clothing store tracks its sales transactions 
according to the following options. Use a tree diagram to list 
all the possible options.

•	 Payment method: credit card, debit card, check, cash
•	 Size category: Juniors, Misses, Women’s
•	 Type of clothing: tops, pants

11. Our 41st president, George Herbert Walker Bush, had 
four names, with initials GHWB. How many different 
possible sets of initials are there for people with four names?
12. NCAA ice hockey games can have the following 
outcomes: win (W), lose (L), or tie (T). In a tournament of five 
games, how many different possible sets of outcomes are there 
for a particular team? (Hint: LLTWW is one possible set.)
13. A college dining service conducted a survey in which it 
asked students to select their first and second favorite flavors 
of ice cream from a list of five flavors: vanilla, chocolate, 
mint chocolate chip, strawberry, and maple walnut. How 
many different possible sets of two favorites are there?
14. A town library is considering loaning video games,  
and surveyed its membership to ask their four favorite 
PlayStation 3 games from among the following six  
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games: Gran Turismo, Call of Duty 4, Metal Gear Solid 4, 
Little Big Planet, Grand Theft Auto IV, and Final Fantasy XIII. 
How many different possible sets of four favorites are there?
15. A woman is considering four sororities to rush this year. 
How many possible orderings are there?
16. Students working for the college newspaper have six 
drop locations around campus at which they must drop off 
newspapers. How many different possible routes are there 
for the students to do so?

For Exercises 17–22, find the value of each factorial.
17. 6!
18. 9!
19. 0!
20. 11!
21. 1!
22. 15!
23. A woman is considering four sororities to rush this year, 
but only has time to rush two. How many possible orderings 
are there?
24. Students working for the college newspaper have six 
drop locations around campus at which they must drop off 
newspapers, but they only have enough time to get to four 
locations. How many different possible routes are there for 
the students to do so?

For Exercises 25–32, find the value of each permutation nPr.
25. 7P3

26. 7P4

27. 8P5

28. 8P3

29. 100P1

30. 100P0

31. 100P100

32. 100P99

For Exercises 33–40, find the value of each combination nCr . 
Then answer Exercises 43 and 44.
33. 7C3

34. 7C4

35. 11C8

36. 11C9

37. 11C10

38. 11C11

39. 100C0

40. 100C1

41. How many distinct strings of letters can we make by 
using all the letters in the word PIZZA?
42. How many distinct strings of letters can we make by 
using all the letters in the word PEPPERONI?
43. Explain why the answers to Exercises 33 and 34 are 
equal. Use the commutative property of multiplication (for 
example, 2 · 7  =  7 · 2) in your answer.
44. Use the idea behind your answer to Exercise 43 to find a 
combination that is equal to 11C8. Verify your answer.
45. List all the permutations of the following people taken 
three at a time: Amy, Bob, Chris, Danielle. What is 4P3?
46. List all the combinations of the following people taken 
three at a time: Amy, Bob, Chris, Danielle. What is 4C3?

47. Explain in your own words why 4P3 is larger than 4C3.
48. What quantity do we divide 4P3 by to get 4C3? Express 
this quantity as a factorial. (Hint: For example, if the 
quantity were 120, we would express it as 5!)
49. In general, what do we divide nPr by to get nCr?

applyinG the ConCepts

50. fast food. A fast-food restaurant has three types of 
sandwiches: chicken sandwich, fish sandwich, and beef 
burger. The restaurant has two types of side dishes: French 
fries and salad.

a. Draw a tree diagram to find all the different meals a 
customer can order at this restaurant.

b. How many different meals can a customer order at 
this restaurant?

51. What to eat? A sit-down restaurant has two types of 
appetizers: garden salad and Buffalo wings. It has three 
entrees: spaghetti, steak, and chicken. And it offers three 
kinds of desserts: ice cream, cake, and pie.

a. Draw a tree diagram to find all the different meals a 
customer can order at this restaurant.

b. How many different meals can a customer order at 
this restaurant?

52. Greek alphabet. The ancient Greek alphabet had  
24 letters. How many different possible initials are there for 
people with a first and last name?
53. facebook friends. A student has 10 friends on her 
Facebook page. How many ways can she arrange her 10 
friends top to bottom?
54. Document Delivery. A document delivery person must 
deliver documents to five different destinations within a 
particular city. How many different routes are possible?
55. traveler fellow. A corporate sales executive must 
travel to the following countries this quarter: China, Russia, 
Germany, Brazil, India, and Nigeria. How many different 
routes are possible?
56. sales traveler. A corporate sales executive has the 
choice of traveling to four of the following six countries this 
quarter: China, Russia, Germany, Brazil, India, and Nigeria. 
How many different routes are possible?
57. playing Catch. Five children are playing catch with a 
ball. How many different ways can one child throw a ball to 
another child once?
58. Chimp Grooming. Six chimpanzees are grooming each 
other at the city zoo. In how many different ways can one 
chimp groom another?
59. shake hands. In an ice-breaker exercise, each of  
25 students is asked to shake hands with each of the other 
students. How many handshakes will there be in all?
60. statistics Competition. Three students from the Honors 
Statistics class of 15 students will be chosen to represent the 
school at the state statistics competition. How many different 
possible groupings of 3 students are there?
61. How many random samples of size 1 can be chosen 
from a population of size 20?
62. How many random samples of size 20 can be chosen 
from a population of size 20?
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63. How many random samples of size 10 can be chosen 
from a population of size 20?
64. How many distinct strings of letters can be made using 
all the letters in the word MATHEMATICS?
65. How many distinct strings of letters can be made using 
all the letters in the word BUSINESS?
66. acceptance sampling. A shipment of 25 personal 
digital assistants (PDAs) contains 3 that are defective. 

A quality control specialist inspects 2 of the 25 PDAs. If 
both are defective, then the shipment is rejected.

a. Explain whether a permutation or a combination is 
being used.

b. Find the number of ways that both PDAs will be 
defective.

c. Find the probability of rejecting the shipment.

Chapter 5 Formulas and Vocabulary
seCtion 5.1

 ● Classical method of assigning probabilities (p. 244).

PsEd 5
number of outcomes in E

number of outcomes in sample space
5

NsEd
NsSd

 ● event (p. 241)
 ● experiment (p. 241)
 ● law of large numbers (p. 249)
 ● law of total probability (p. 241)
 ● outcome (p. 241)
 ● probability (p. 240)
 ● probability model (p. 241)
 ● relative frequency method of assigning probabilities 

(also known as the empirical method) (p. 249).

PsEd <
frequency of E

number of trials of experiment

 ● sample space (p. 241)
 ● simulation (p. 248)
 ● subjective probability (p. 252)
 ● tree diagram (p. 245)

seCtion 5.2
 ● addition rule (p. 262). 

 P(A or B) = P(A ∪ B) = P(A) + P(B) – P(A ∩ B)
 ● addition rule for Mutually exclusive events (p. 264). If 

A and B are mutually exclusive, then P(A ∪ B) = P(A) + P(B).
 ● Complement of an event a (p. 259). Denoted as AC.
 ● intersection of two events a and B (p. 261). Denoted as 

A ∩ B or as “A and B.”
 ● Mutually exclusive (disjoint) events (p. 263)
 ● probabilities for complements (p. 260). 

P(A) + P(AC) = 1, P(A) = 1 – P(AC), and P(AC) = 1 – P(A)
 ● union of two events A and B (p. 261). Denoted as  

A ∪ B or as “A or B.”

seCtion 5.3
 ● Conditional probability (p. 271).

PsB u Ad 5
PsA > Bd

PsAd
5

NsA > Bd
NsAd

 ● independent events (p. 274). Events A and B are 
independent if P(A u B) = P(A) or if P(B u A) = P(B).

 ● Multiplication rule (p. 276). P(A ∩ B) = P(B) P(A u B) 
or, equivalently, P(A ∩ B) = P(A) P(B u A).

 ● Multiplication rule for independent events (p. 277).  
If events A and B are independent, then P(A ∩ B) =  
P(A) P(B).

 ● Multiplication rule for n independent events (p. 280). If 
A, B, C, ... are independent events, then P(A ∩ B ∩ C ∩...) = 
P(A) P(B) P(C ) ... .

 ● sampling with replacement (p. 277)
 ● sampling without replacement (p. 277)

seCtion 5.4
 ● acceptance sampling (p. 300)
 ● Combination (p. 296).

n
C

r
5

n!

r!sn 2 rd!

 ● factorial symbol n! (p. 294). 0! = 1; 1! = 1; n! =  
n(n 2 1)(n 2 2) ... 3 · 2 · 1

 ● Multiplication rule for Counting (p. 293)
 ● permutation (p. 295).

n
P

r
5

n!

sn 2 rd!
 ● permutations of nondistinct items (p. 299).

n
P

r
5

n!

n
1
! ? n

2
! ? Á ? n

k
!

 4. 2 tails
 5. At most 1 tail
 6. a new sonnet. Literature researchers have unearthed a 
sonnet that they know to be by either William Shakespeare 
or Christopher Marlowe. The probability that the sonnet is 
by Marlowe is 25%.

Chapter 5 Review Exercises
seCtion 5.1
For Exercises 1–5, consider the experiment of tossing a fair coin 
three times and find the probabilities of the following events.
 1. 2 heads
 2. At least 2 heads
 3. 4 heads
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a. What is the probability that the sonnet is by 
Shakespeare?

b. What method of assigning probability do you think 
was used here? Why was this method used, and not 
the others?

seCtion 5.2
 7. farmworkers’ educational level. The U.S. Department 
of Agriculture reports on the demographics of hired 
farmworkers.15 An excerpt of the results is provided in the table, 
showing the percentage of noncitizen and citizen farmworkers 
who attained various educational levels. The educational levels 
are mutually exclusive. Find the following probabilities:

a. The probability that a noncitizen farmworker is a 
high school graduate or has some college

b. The probability that a citizen farmworker is a high 
school graduate or has some college

c. The probability that a noncitizen farmworker has less 
than a ninth-grade education and has some college

d. The probability that a farmworker is not a citizen

noncitizens Citizens
Less than 9th grade 238,008  61,776
9th–12th grade (no diploma)  57,904 152,880
High school graduate  59,784 222,144

Some college  20,304 187,200

seCtion 5.3
 8. Drug research studies. The Annals of Internal 
Medicine reported that 39 of the 40 research studies 
sponsored by a drug company had outcomes favoring a 
certain drug. Find the following probabilities, assuming 
independence:

a. Three randomly selected research studies all favor 
this drug.

b. None of the three randomly selected research studies 
favors this drug.

c. At least one of three randomly selected research 
studies favors this drug.

 9. Drug research studies. Use the information in 
Exercise 8. Suppose we sample two research studies without 
replacement. Find the probability that the second study does 
not favor this drug, given that the first study does not favor 
this drug.

Gender and pet preference. Do you think your gender 
affects what type of pet you own? For Exercises 10–13, use 
the following table, showing preferences for various pets by 
owner gender.

Gender of owner Cats Dogs other pets total
Female 100  50 30 180
Male  50  50 20 120

Total 150 100 50 300

10. Find the probability that a randomly chosen person has 
the following characteristics:

a. Owns a cat, P(C )  b. Owns a dog, P(D)
11. Find the probability that a randomly chosen person has 
the following characteristics:

a. Is female and owns a dog, P(F ∩ D)
b. Is male and owns a dog, P(M ∩ D)

12. Find the following conditional probabilities for a 
randomly chosen person:

a. Owns a dog, given that the person is female, P(D u F )
b. Owns a dog, given that the person is male, P(D u M )

13. If you were a dog-food manufacturer, would you 
advertise more on a men’s TV channel or a women’s TV 
channel? Why? Cite your evidence.

seCtion 5.4
14. How many distinguishable strings of letters can be made 
using all the letters in the word MISSISSIPPI?
15. statistics quiz. On a statistics quiz, there are five true/
false questions, four fill-in-the-blank questions, and three 
short-answer questions. How many different ways are there 
of taking this quiz?
16. inspection time. A U.S. Army drill instructor will 
perform inspection on 2 soldiers in a squad of 18 soldiers. If 
both soldiers fail the inspection because their rifles are not 
clean, the entire squad will have to run a five-mile course in 
full gear. Three of the 18 soldiers have rifles that are not 
clean.

a. Explain whether the drill instructor is using a 
permutation or a combination.

b. Find the number of ways that both soldiers will fail 
the inspection.

c. Find the probability that the entire squad will have to 
run a five-mile course in full gear.

chapter 5 Quiz

true or false
 1. True or false: An outcome is a collection of a series of 
events from the sample space of an experiment.
 2. True or false: For any event A (even events like A: the 
moon is made of green cheese), the probability of A plus the 
probability of AC always add up to 1.

fill in the BlanK
 3. The minimum value that a probability can take is 
_________ and the maximum value is _________.
 4. The union of two events is associated with the English 
word _________, and the intersection of two events is 
associated with the English word _________.

306 Chapter 5 Probability
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 5. Someone has told you that there is a 50-50 chance of 
rain tomorrow. This means that the probability of rain 
tomorrow equals _________.

short ansWer
 6. For any experiment, what is the sum of all the outcome 
probabilities in the sample space?
 7. For which type of sampling are consecutive draws 
independent?
 8. For two events A and B, what do we call the event 
containing only those outcomes that belong to both A and B?

CalCulations anD interpretations
 9. Consider the experiment of rolling a fair die twice. Find 
the following probabilities:

a. Sum of the two dice equals 5.
b. Sum of the two dice does not equal 5.
c. One of the dice shows 2.
d. Sum of the two dice equals 5 and one of the dice 

shows 2.
e. Sum of the two dice equals 5 or one of the dice 

shows 2.
10. Suppose that A and B are any two events, with P(B) = 
0.75 and P(A ∩ B) = 0.15. Find P(A u B).
11. Suppose that A and B are any two events, with P(B) = 
0.85 and P(A u B) = 0.25. Find P(A ∩ B).
12. pick a Card. Consider the experiment of drawing a 
single card from a deck of 52 cards. Find the probability of 
observing the following events:

a. Heart d. Red card
b. Face card e. Seven of 
   (king, queen, or jack)  hearts
c. Seven f. Red queen

For Exercises 13–18, let the experiment be to toss two fair 
dice. Use the sample space in Figure 3 on page 247. Define 
the following events:

X: Roll a sum equal to 9.
Y: Roll a sum equal to 10.
Z: Roll doubles, where the dark green die equals the 
light green die.
W: Light green die equals 6.

Use the strategy for determining whether two events are 
independent (page 274) to determine whether the following 
pairs of events are independent:
13. X and Z
14. Y and Z
15. X and W
16. Y and W
17. X and Y
18. Z and W
19. football teams. The four teams in the AFC South 
division of the National Football League are Indianapolis 
Colts, Jacksonville Jaguars, Tennessee Titans, and Houston 
Texans. Suppose the top three teams in the division this year 
will make the playoffs. How many different sets of teams are 
making the playoffs?
20. state lottery. In a state lottery, balls numbered 1 to 20 
are placed in an urn. To win, you must choose numbers that 
match the three balls chosen in the order that they’re chosen.

a. Explain whether a permutation or a combination is 
being used.

b. How many possible outcomes are there?
c. Find the probability of winning this lottery if your 

ticket contains a single ordering of three numbers.
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